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Abstract

By accommodating users with diverse needs and backgrounds,
user interfaces are revolutionizing the application of computers. Intuitive
interfaces allow the user to perform complex tasks with little knowledge
of the underlying logic. A popular approach in Artificial Intelligence for
temporal knowledge representation and reasoning is to use first order
logic. In order to use logic the user must understand its syntax and
semantics. This thesis presents a logic independent graphical user
interface (GUI) and discusses the principles of user interface design. The
GUI allows the user to enter, query, and receive temporal information
using color-coded symbols. The user does not have to be familiar with

the particular logic used by the implementation.
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CHAPTER 1. INTRODUCTION

Chapter 1

Introduction

“As natural selection works solely by and for the good of each being, all
corporeal and mental endowments will tend to progress towards
perfection.”

Charles Darwin, Origin of Species

Every interesting real world problem has a temporal component.
For example, if we want to simulate a telephone switch in software, the
software must be able to deal with the representation of simultaneous
calls of varying duration. From our everyday life, we are aware that the
symptoms of a disease change over time. Another example from the
internet would be an intelligent dynamic web site that monitors the time,
duration and type of hits, and modifies its presentation over a 24 hour
time period in order to best serve its clients. Therefore, if we are to use a
computer to solve real problems, time must be explicitly represented. A
popular approach in Artificial Intelligence for temporal knowledge

representation and reasoning is to use first order logic.
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One drawback with using logic is that the user must understand
its syntax and semantics in order to interact with the implementation.
This thesis presents a logic independent graphical user interface (GUI).
The GUI allows the user to enter, query, and receive temporal
information using color-coded symbols. The user does not have to be

familiar with the particular logic used by the implementation.

The main research challenge is the definition of the GUI. The GUI
should be designed and implemented in such a way that it is easy to
learn, use, efficient and effective. It should allow the user to enter and
query temporal information using icons and color-coded symbols. For
example, using a pull down menu the user could choose “John is
sleeping”. The user then places a dot on a horizontal time line at 2 a.m.
to specify that John is sleeping at this time. The user can alternatively
place a line to represent a time interval. Precise quantitative point and
interval based information is easy to represent graphically. Challenging
types of information, which are difficult to represent, are “Ill meet you
later”, “It rained throughout the day today”, and “Bob played squash and

tennis for equal amounts of time”.
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Constraint logic programming and temporal reasoning is
introduced in the next chapter.

Chapter three discusses features of effective, efficient and user-
friendly GUTI’s.

Chapter four gives a system overview. This chapter concentrates on
the processes of representing time, entering and querying information.

Chapter five presents the inference engine, which is the backbone
of the system and the knowledge base.

Chapter six discusses evaluation of the user interface.

Chapter seven presents directions for future work and conclusions.
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Chapter 2

Temporal reasoning and constraint logic
programming (CLP)

“Any sufficiently advanced technology is indistinguishable from magic.”
-- Arthur C. Clarke

This chapter introduces constraint properties and temporal
constraints, followed by a discussion on logic and temporal reasoning.
Constraint logic programming is explained in detail with the help of

examples. Finally, we present ECLPSe and its features.

2.1 Constraints

Constraints have many properties that make them unique and
flexible for our use in Al and computer science applications [Magh95]:

e Constraints and multi-object relationships: Constraints can involve

relationships between multiple objects:

John and Steve must live in separate towns. (1)
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The relationship “live in separate towns” treats John and Steve
equally. It gives the same amount of information about both. It does
not give information of where each one lives, but it gives specific
information about a relationship between the two.

e Adirectional property: There are no computational directions or flow of

information represented in a constraint. In (1), there is no
specification of which one is first, and there is no priority. Knowing
one of John’s or Steve’s residence, it gives us information about the

other.

e Partial knowledge representation: Constraints allow the specification
of partial knowledge. We do not need to know everything about the
domain of discourse or the relationships between individuals when
writing constraints. For example:

John has a table in his living room.
is acceptable by itself. It is not necessary to specify all the constraints
that apply to John’s house.

e Constraint representation: A constraint usually does not have a

unique representation. For example:
The Bar is open between 8:00 a.m. and 12:00 p.m.
and,

The Bar is closed between 12:00 p.m. and 8:00 a.m.
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both have the same meaning but are represented in different ways.
The particular representation chosen usually depends on the problem
domain and implementation.
e Soft constraints: An example of a soft constraint is:
John'’s table can be red.
This does not mean that John’s table is red, but implies that red is a
possible color or an expected color of John’s table. These soft

constraints give expectations or predictions.

2.1.1 Temporal constraints

Constraints can be atemporal:

John eats dinner.
This constraint does not specify when John eats his dinner. If we
introduce time:

John eats dinner at 6:00 p.m.
We know what John is doing at 6:00 p.m. Time can give constraints a
temporal limit, which makes them more accurate and precise. For
example:

Mary works from 9:00 a.m. to 6:00 p.m. (2)
specifies an occupation for Mary between the time limit (9:00 a.m. — 6:00
p.m.). If in addition we have:

Mary works at the Library.
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then using (2), we know that Mary is in the Library between 9:00 a.m. —
6:00 p.m. These two constraints influence any solution sought or
decision to be taken concerning Mary. If for example, something
happened at 10:00 a.m. at the Halifax Shopping Mall, we can conclude

that Mary was not involved in it.

2.2 Logic and Temporal Reasoning

Logic consists of a formal system for describing states of affairs,
using the syntax and semantics of the language. Syntax describes how
to write valid sentences and semantics state how sentences relate to
states of affairs. There are various kinds of logic such as propositional,

first order, and fuzzy logic [Russ95].

We concentrate on a variant of first order logic for temporal
reasoning, which assumes that the world is ordered by a set of time
points and/or intervals, and includes built in mechanisms for reasoning
about time.

Formulas in a first order temporal logic denote statements whose
truth-value may change over time. Examples of such statements are:

e [t is presently raining.
o John was on the phone between 2 and 4 p.m.

e Mary came in at 3 p.m. and left later.
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2.3 Temporal information

There are four types of temporal information:
1. Point based qualitative information.
2. Interval based qualitative information.
3. Point based quantitative information.

4. Interval based quantitative information.

An example of point based qualitative information is:

John is working at time t;.

An example of point based quantitative information is:

John is walking at a speed of 5 km/hr at time #;.

An example of interval based qualitative information is:

John was working from time ¢, to t.

An example of interval based quantitative information is:

John worked for 1 hour from time t; to 2,
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2.4 Constraint Logic Programming (CLP)

Constraint Logic Programming [Fruh93] is a new class of
programming languages combining the declarativity of logic
programming with the efficiency of constraint solving. New application
areas, amongst them many different classes of combinatorial search
problems such as scheduling, planning or resource allocation can now be
solved, which were intractable for logic programming. The most
important advantage that these languages offer for certain problems is
short development time while exhibiting an efficiency comparable to

imperative languages.

Constraint Logic Programming adds richer data structures to a
logic programming system thus allowing semantic objects (e.g.,
arithmetic expressions) to be directly expressed and manipulated. Logic
programming has a uniform but simple computation rule, a depth-first
search procedure, resulting in a generate and test procedure with its
well-known performance problems for large search applications [Fruh93].
Constraint logic programming overcomes this problem by its active use of
constraints, pruning the search tree in an a priori way. The key aspect

is the tight integration between constraint evaluation and search.
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Constraint solving has been used in many different application
areas such as engineering, planning and graphics [Fruh93]. Problems
such as scheduling, allocation, layout, fault diagnosis and hardware
design are typical examples of constrained search problems. A reason for
the success of CLP in recent applications has been the choice of
constraint systems integrated into the different implementations. The
selection of new constraint domains needs to satisfy both technical and

practical criteria [Jaff87]:

e The expressive power of the computation domain,
e The existence of a complete and efficient constraint solver,

e [ts relevance in applications.

The constraint solver is complete if it is able to decide the
satisfiability of any set of constraints of the computational domain. To
achieve efficiency the constraint solver needs to be incremental, i.e. when
adding a new constraint C to an already solved set of constraints S, the

constraint solver should not start solving the new set Su { C} from

scratch.

10
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2.4.1 Programming with constraints

The amalgamation of logic programming and constraints is called
constraint logic programming (CLP). A CLP interpreter must have two
components: an inference engine which deals with resolution, and a
domain-specific constraint engine which maintains the constraint store
in a standard form, and upon a request from the inference engine, is able
to inform it whether the constraints it suggests can be consistently

added to the store.

Examples of CLP systems are CHIP [Dinc88|, CLP(R) [Hein92] and
ECL®PSe [Abde95]. An example of ECLPSe code is shown in figure 2.4.1.
Interval based information is represented using the integral relation.
integral (a,b, £, x) is true if and only if the integral of f from a to b is x.
We use a limited version of the integral relation which can be viewed as

the measure of the duration of truth of f over the interval (a,b).
For example, “running” is true throughout the interval (0,10) is written

as integral (0,10,running,10). and “running” for half the time is

integral (0,10, running,5).

11
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Information that is true at an isolated point is represented using
the point relation. For example, “running” is true at time 5 is written
as point (5, running) .

point(T,F) :-

A #<=T,
B #>= T,
C #= B"A'

integral(A,B,F,C).

integral(0,10,running,10).
Figure 2.4.1 ECLPSe code for point and integral

To determine if F is true at an isolated point T, we can look for an
interval (A,B) which contains T and over which F is true throughout. This
strategy is captured by the first rule in figure 2.4.1.

Computation begins with a goal and an empty set of constraints.
An arithmetic constraint or an atom is selected with the usual left-right
atom selection rule at each stage. When an atom is selected, the set of
rules is searched in the usual top-down fashion, each time matching that
atom with the head of some rule. Execution proceeds as in PROLOG
until a constraint is encountered. When a constraint is selected it is
added to the set of collected constraints, and it is determined whether
the resulting set has a solution. If no solution is found, backtracking
occurs. At every point in the derivation, the set of constraints is

satisfiable.

12
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Let us return to the program in figure 2.4.1, and examine a successful

execution path:

? — point(X,running).

{} ? - point(X,running).

{T=X, F=running} ? - A#<=T, B#>=T, C#=B-A, integral(A, B,running,C).
{T=X, F=running, A#<=T} ? — B#>=T, C#=B-A, integral(A,B,running,C).
{T=X, F=running, A#<=T, B#>=T} ? — C#=B-A, integral(A, B,running,C).
{T=X, F=running, A#<=T, B#>=T, C#=B-A} ? - integral(A,B,running,C).
{T=X, F=running, A#<=T, B#>=T, C#=B-A, A=0,B=10,C=10} ? -

At each step, the set of constraints is shown on the left of “ ?- ”.
Note that at the first step, the set is empty. In the penultimate step,
integral(A,B,F,C) unifies with integral(0,10,running,10) ECLPSe solves

the final set of constraints and returns the answer:
X=0..10

This means point(X,running) is true whenever X has a value between 0
and 10.

2.4.2 CLP vs. logic programming

Constraint logic programming is a generalization of logic
programming. Program execution in ECLPSe is similar to PROLOG ’s, but

unification is more general. Executing the code shown in figure 2.4.1 in

13
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ECLPSe and the PROLOG equivalent code at the top of figure 2.4.2.2

gives the results shown in figure 2.4.2.1.

Query PROLOG ECLPSe
point(S, running) NO YES
point(X, running) NO YES X =0..10

Figure 2.4.2.1 Comparison between PROLOG and ECLPSe

PROLOG Code:

point(T,F) :-
A =< T,
B >= T,
C = B-A,

integral (A,B,F,C).

integral (0,10, running, 10).

PROLOG execution:

?- point(5, running).

Integer required

No

?- point (X, running).

I

Integer required

No

PROLOG code and its execution for point(5, running) and point(X,
running).
Figure 2.4.2.2

14
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Due to the presence of the arithmetic constraint A=<T, PROLOG is
unsuccessful with the unification. The PROLOG code and its execution
for point(5, running) and point(X, running) are shown in figure 2.4.2.2.

The proof trees are as follows:

?- point(5,running).
?-A =<5, B>=5, C = B-A, integral(A,B,running,C).
Fails. (Cannot associate any value with A in the goal A =< 5.)

?- point(X,running).
?-A =< X, B>=X, C = B-A, integral(A,B,running, C).

Fails. (Cannot associate any value with A in the goal A =< X.}

In the proof tree for point(S,running), PROLOG tries to solve A =< 5
but is not able to unify any value with A and fails. Similarly, in
point(X,running), PROLOG is unable to unify any value with A.

As shown above, PROLOG does not deal with constraints.
Therefore, to handle constraint based problems for temporal reasoning
we need a more powerful constraint-solving environment, which is

provided by CLP.

15
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2.5 ECLiPSe (CLP)

The CLP system we use in our implementation is ECLPSe. ECLPSe
(ECRC Common Logic Programming System) [Abde95] is a development
environment for constraint programming applications. It contains
several constraint solver libraries, which use extended PROLOG
technology with persistent knowledge base and constraint handling

features.

Features of ECLiPSe;

¢ Incremental Compiler: ECLPSe is based on an incremental interactive

compiler. ECLPSe programs are both fast and flexible.

® Source Variable Names: ECLPSe is able to remember the source

names of variables so that debugging programs becomes easier.

@ Flexibility: ECLPSe enables the user to modify most of the system

features, build separate applications or include new features.

16
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e Memory: All ECLPSe memory areas are automatically extended when
necessary. There are no limits (other than the available memory) to
the size of atoms or strings or their number, the length of integers and

there is no limit on the complexity of compiled clauses.

e Strings: ECLPSe has the data type string whose representation is

compact and compatible with strings in C and Tcl/Tk.

e Complete Search Rule: Most PROLOG systems implement logic

programming incompletely because they use the depth-first search,

but ECLPSealso supports depth-first iterative search along with DFS.

® Modules: ECLPSe has a sophisticated modular concept that makes it

possible to build large applications, avoid name clashes and to hide

information from unauthorized access.

® Stream [/0O: The ECLPSeI/0 is based on the concept of streams that

are mapped on the I/O channels of the underlying operating system.

® On-line Documentation: The PROLOG Built-in Predicate Reference

Manual is available on-line. Calling help (PredSpec) will display the

appropriate manual page.

17
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Chapter 3

Graphical User Interface.

“The hope is that, in not too many years, human brains and computing
machines will be coupled together very tightly and that the resulting
partnership will think as no human brain has ever thought and process
data in a way not approached by the information-handling machines we
know today.” J.C.R Licklider, 1960 outline of “Man-Computer
Symbiosis”

3.1 Introduction

A user interface is the boundary between a computer system, comprising
of hardware and software, and the human user. User interface software
is a significant component of contemporary computer systems and
graphical user interfaces (GUI’s), are now ubiquitous.

The main challenge in designing a temporal expert system shell is
developing a graphical user interface with the following characteristics

[Norm93]:

18
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e Easy to use,

e FEasy to learn,

e Effective and efficient,

e Completely represents the situation,

e Logic system independent,

e Incorporates semantic graphic symbols and icons

with meaningful colors.

This chapter begins by considering notions of correctness and
means of achieving it. Then, it discusses the significance of Human
Computer Interaction (HCI). Finally, this chapter discusses the tools and
techniques for graphical user interface design focussing on the

significance of color, graphics and icons.

3.2 What is Correctness?

The IEEE Standard Glossary of Software Engineering Terminology
[Ises94] defines correctness in terms of freedom from faults, meeting of
specified requirements, and adherence to user needs and expectations.
Software correctness is more commonly described using the terms

validation and verification:

19



CHAPTER 3. GRAPHICAL USER INTERFACE

Validation asks
Are we building correct software?
Verification asks

Are we building the software correctly?

Both validation and verification are important. Validation failure
constitutes a breech of contract between the developer and the client for
whom the software is being produced. Verification failure results in
software containing potential faults or flaws. Clearly, neither is
desirable.

Although correctness is important for software in general, it is
particularly important for graphical user interfaces. The graphical user
interface represents the aspect of the software that is directly perceived
by a user. If the user interface is incorrect, the software will be
perceived as incorrect or inadequate, regardless of the correctness of the
underlying functionality.

Confidence in the correctness of a graphical user interface is
usually achieved by prototyping or by testing. Prototyping can be used to

validate and to verify that the interface meets usability requirements.

20
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3.3 Significance of HCI in designing GUI

Human computer interaction is a discipline concerned with the design,
evaluation and implementation of interfaces for interactive computing
systems for human use and the study of major phenomena surrounding
them.

Donald Norman [Norm95] suggests three key principles that help

to ensure good HCI:

e Visibility,
e Affordance,

e Feedback.

Controls need to be visible with good mapping with their effects
and their design should also suggest their functionality. Affordance
refers to the properties of objects, i.e., the operations and manipulations
that can be done to a particular object. For example, doors can afford
opening, and chairs afford support. The concept of feedback is
straightforward, there should be a response to actions. This gives a
sense of closure and certainty that the command has been received or
the operation has been successful.

In order to produce computer systems with good usability, it is

essential to keep in mind the following:

21
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1. The user interface is a large and complex component of a software
system. Needs of the user are very critical. Designers should survey
the intended users of the system before making decisions, since
incorrect assumptions about the users may lead to inappropriate
design decisions.

2. A new system’s interface should be compatible with other interfaces,
taking into consideration technology advances. This principle is
demonstrated in software for Microsoft Windows and for the Apple
Macintosh. Most software for these environments have the same
basic interface techniques.

3. When a designer designs an interface it is a mistake to provide too
much functionality. This flaw can result in an interface that is
complex and difficult for novice users to navigate. However, Mayhew
[Mayh92] suggests that it is possible to provide an interface that is
rich in functionality, but easy to use.

4. The user interface should be organized so that users can perform
more than one task at a time and switch easily between tasks. This
usability feature is demonstrated in the Microsoft Windows
multitasking environment. A modal dialog window requires that the
user interact with it before interacting with any other window, e.g.,

password dialog box.
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S.

A system should always respond to a user’s input. The user should be
kept abreast with the internal processes that are being executed by
the computer. Messages like “Please Wait ...” or “Working ...” should
be used to let the user know that the system is executing a process.

Facilities for direct manipulation with the interface. The user should
be able to perform actions on visual objects instead of using a
command interface. This is a typical feature of all window
environments. The interface usually gives the user point and click
access. Direct manipulation provides a direct and easy to use

interface.

. Information pertaining to the internal functions of the system should

not be presented to the user, since this type of information can be
confusing. If this is unavoidable, then the information should be
presented in a simple and convenient manner.

Flexibility is an important principle, since it accommodates variations
in the user’s skills and preferences. This could be one of the difficult
features to incorporate.

A system should tolerate errors made by the user. System crashes
should be minimized and simple recovery measures presented, such
as an UNDO button. An over sensitive system will inhibit the user’s
ability to learn the system and their productivity by making them

work slower to avoid errors.
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Underlying all HCI research and design is the belief that the people
using a computer system should come first. Their needs, capabilities
and preferences for performing various activities should drive system
design and implementation. People should not have to change radically
to fit in with the system, the system should be designed to match their
requirements.

Our ability to attend to one event from among competing stimuli in
an environment has been psychologically termed as Focused Attention
[Norm95]. The streams of information we choose to attend to, will tend
to be relevant to the activities and intentions that we have at that time.
When we attempt to attend to more than one thing at a time, it is called
Divided Attention. The means for guiding attention within the context of

a GUI are:

o Important information or information that needs immediate
attention should be displayed in a prominent place to catch the
user’s eye.

& Screens should be structured for easy navigation.

o Information should be grouped and ordered into meaningful
parts.

» Alerting techniques such as error dialog box, reverse video and

auditory warnings should be used.
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¢ Windows should be used to partition the computer screen into

discrete or overlapping sections.

3.4 Tools and techniques for designing a GUI

People interact with their world through the mental models that they
have developed. Specifically, the ideas and the abilities they bring to the
job are based on the mental models that they develop about that job. As
interface designers we need to help the user in developing mental models
of the system that will aid him or her to understand the job and perform
the task.

The proper use of color, graphics, symbols and icons
communicates facts and ideas more quickly and aesthetically to the user.
In the following sections, color, graphics and icons are discussed in

further detail.

3.4.1 Color

Color provides an effective way to structure information as well as makes
the environment pleasant and enjoyable to look at. Excessive use of
colors, however, results in color pollution. Many cognitive tests have
been performed to find out the relevance of colors and the main findings

are:
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e Segmentation: Color is a very powerful way of dividing a display into

separate regions. Color can be used to emphasize as well as

categorize data. It can also facilitate searching through information.
o Simplicity: It is more difficult to use color effectively that it is to use it
ineffectively. Simplicity is important in the design of color interfaces.

Do not attach more than one meaning to a color.

e Restrict number of colors with meaning: The magic number [Mill56]

for short-term memory is seven plus or minus two.

e Consistency: The intuitive ordering of color can help establish

intuitive consistency in the design. The spectral and perceptual order
red, green, yellow, blue can guide the order of concepts attached to
colors. Red is first in the spectral order and focuses in foreground,

green and yellow focus in the middle, while blue in the background.

e Prominence: Color should be used to make features prominent. For

example, currently active files could be shown in a different color.
Standardized interface colors should be established and used across
the development. For example, red is a good color to alert the user for
an error. Yellow is appropriate for a warning message, and green to

show positive progress.
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Table 3.4.1 shows good and bad color combinations [Panc95]. As

explained in the table below, for a white background, the best text color

would be black or blue and the worst color would be cyan and yellow.

Background Best Colors Worst Colors
White Black, Blue Cyan, Yellow
Black Yellow, White Blue

Red Black Blue, Magenta
Green Black, Red Cyan
Blue Red, White, Yellow Black
Cyan Blue, Red Green, White, Yellow
Magenta Black, Blue Cyan, Green

Table 3.4.1 Color Combinations for Graphical User Interfaces.

Marcus [Marc90] has given some effective suggestions for creating good

interfaces:

e Use dark colors for background.

e Opposite colors go well together.

o Avoid the simultaneous display of highly saturated, spectrally

extreme colors. For example, bright violet with red.

e Avoid using adjacent colors that differ only in the amount of

pure blue.

« Use bright colors for danger or for getting the user’s attention.
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3.4.2 Graphics

Graphics help to present objects in a pictorial rather than verbal form. It
is true that a picture is worth a thousand words and a chart is worth a
dozen tables of numbers. The human ability to extract information from
visual scenes is more fundamental than the ability to manipulate data

arithmetically. Graphics can be used for the following [Marc90]:

e To display complex relationships,

e To show component relationships (e.g. mimic display of car),
e For dynamic data,

e Map display for geographic data,

e To display trends/projections (e.g. stock market data),

e For quick interpolation.

3.4.3 Icons

Icons are small pictorial images that are used to represent system
objects, application tools such as those for drawing, utilities and
commands. For example, as part of a desktop metaphor, objects

associated with working at an office desk such as phone diaries,
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schedulers are depicted as icons. These icons reduce the complexity of
the system, making it easier to learn and use.

Advantages to using icons:

e Icons are easy to understand.

e Icons save space.

o Icons can permit international use.

e Icons are effective for tasks that require a diversity of
manipulative operations to be performed (e.g., range of drawing
and painting techniques.)

e Icons act as mnemonic tags for tasks where large amounts of

information have to be readily identified.

3.5 Other expert system shells
Some of the expert system shells are:

ACQUIRE: ACQUIRE [Acqi97] is a knowledge acquisition system and an
expert system shell. It is a complete development environment for
building and maintaining knowledge-based applications. It provides a
step-by-step methodology for knowledge engineering that allows the
domain experts themselves to be directly involved in structuring and
encoding the knowledge. Features include a structured approach to

knowledge acquisition, a model of knowledge acquisition based on
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production rules and decision tables, handling uncertainty by
qualitative, non-numerical procedures.

FOCL: FOCL [Focl92] is an expert system shell written in common LISP.
It learns Horn Clause programs from examples and background
knowledge. The expert system includes a backward-chaining rule
interpreter and a graphical interface to the rule and fact base.

FLEX: FLEX [Flex94] is a hybrid expert system shell available across a
wide range of different hardware platforms which offers frames,
procedures and rules integrated within a logic programming
environment.

BABYLON: BABYLON [Baby96] is a development environment for expert
system. It includes frames, constraints, prolog-like logic formalism, and
a description language for diagnostic applications. It is implemented in
common LISP and has been ported to a wide range of hardware

platforms.

In summary, user interface software is complex, highly interactive,
modeless, concurrent, graphical, and has user-based real-time
requirements. Emerging user interface technologies such as multi-modal
interaction, multi-media and intelligent agents will give it a prominent

position in any software development process.

30



CHAPTER 4. SYSTEM OVERVIEW

Chapter 4

System overview

“To every thing there is a season, and a time to every purpose under the
heaven; A time to be born and a time to die; a time to plant, and a time to
pluck up that which is planted; A time to kill, and a time to heal; a time to

break down, and a time to build up.”
- The Bible, Ecclesiastes, 3

Tcl/Tk is a development toolkit for building GUI’s. The Tool
Command Language (Tcl) is the embedded scripting language and Toolkit
(Tk) builds widgets on top of Tcl.

This chapter begins with an introduction to Tcl/Tk. The model,
illustrating the various phases involved in building a temporal expert
system shell, is explained. Then, this chapter talks about system specific

details including entering, representing and querying information.
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4.1 Tcl/Tk

Tecl is a scripting language for controlling and extending
applications. It provides generic programming facilities such as variables,
loops and procedures that are useful for a variety of applications.

Tk is the graphical user interface extension for applications created
using Tcl. Tk extends core Tcl facilities with commands for building user
interfaces. Tk is used to create widgets, arrange widgets, and bind
events to Tcl commands.

Various advantages [John97] of using Tcl/Tk for developing
graphical user interfaces are:

o Scripting language: While there are a few compilers, the vast majority

of Tcl users run their programs as scripts. Scripts are easier to
develop and faster to execute than full-fledged C or C++ programs
because there is no need to compile and link the program. The Tcl
user just executes the Tcl interpreter and runs the script.

o Easy to learn: Unlike other programming languages, Tcl/Tk is easy to
learn and use.

o Works on many different platforms: Tcl works well in the Unix

environment, particularly because developing graphical applications
on Unix under Motif tends to be a troublesome task. This is one of
the main reasons for the success of Tcl/Tk. On the Windows side,
versions of Tcl exist for Windows 3.1, Windows 95 and Windows NT.

The latest version of Tcl also runs on Apple’s Macintosh platform.
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Extension and modification: One of the main uses of Tcl is that it is

possible to add commands to Tcl, thereby, extending the language.
The Tcl interpreter is a C function that can be linked with various
applications.

Tcl/Tk is free: Tcl/Tk is available for free, on the Internet. This

feature of the language makes it popular amongst the student
community.

Works well with the Internet: Tcl includes a number of built-in

features that make working with World Wide Web pages easier. The
text widget, for example, supports tags that help in creating hypertext

links in the text. Tcl is good for CGI scripts as well.

4.2 Conceptual Model

We use Tcl/Tk to implement the GUI. The GUI is one component of our

system. The block diagram in figure 4.2 gives an overview of the system.

)
T

Inference Knowledge
Engine — Base

Figure 4.2 Conceptual Model
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The GUI provides the environment for representing, entering and
querying information. The translator is a set of Tcl instructions, which
provides a link between the graphical user interface and the inference
engine. It maps the information entered by the user onto the logical form
and stores it as facts in the knowledge base. Every fact contains the
following information:

e Unique color that represents an event.

e Temporal information associated with that event.

The inference engine is the backbone of the temporal expert system
shell. It interacts with the knowledge base, which contains facts to solve
the queries requested by the user. The result of the query is sent back to
the translator, where it is mapped from logical to user understandable
graphical form. The inference engine and knowledge base are discussed
in chapter S. The graphical user interface and translator are discussed

in the remainder of this chapter.

4.3 Graphical User Interface

e Entering Information:

The screen shown in figure 4.3.1 is used to enter information. An
event is defined as a single item of temporal information. Every event has
a name, description and a temporal component. For example:

e John had a meeting at 4 p.m.
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The event name for this event is “Meeting”, the event description is
“John had a meeting at 4 p.m.” and the temporal component is that it is
true at 4 p.m. Another example is:

e [ went jogging between S5 p.m. and 5:30 p.m.
The event name for this event is “Jogging”, the event description is “I
went jogging between 5 p.m. and 5:30 p.m.” and the temporal component

is that it is true between S p.m. and 5:30 p.m.

Entering Intormation

Figure 4.3.1 Screen for Entering Information

The text entry box labeled “Event Name” is used for entering the

name of an event. The “Event description” text box provides a location
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for adding event details. The user can move from one data field to
another either by tabbing to, or by clicking in the desired field. The
system prompts the user with an error message, if any of these text

boxes are left empty.

Figure 4.3.2 Color Window

The next step is to pick a color. The “Pick Color” button in figure
4.3.1 invokes the color window shown in figure 4.3.2. The user can
select a color for an event by filling in the numerical values for red, green
and blue. Numerical values for each of these primary colors range
between 0 and 254. It is also possible to select a color by sliding the
triangular tab on the color scale for each color. The selection text box
and the color display window (they both appear in the right hand side of
the window in figure 4.3.2) change their color values as the user slides
the triangular tab on the color scale. The user confirms his/her selection

by clicking on the “OK” button.
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Every event is represented by a unique color. This unique color is
used as an index for the event. We can represent a total of 255*255*255
events.

The unique color associated with each event is used in querying
information from ECLPSe¢ and in maintaining database integrity. It
should be noted that if the user attempts to pick the same color for more
than one event, the system flags an error message and prompts the user
to pick another color. As a visual cue, symbolic icons used later will
have the same color as the event. The user can change or modify any
information entered up to this stage.

There are different categories of events that can be represented.
Depending upon the category of an event, the user chooses an icon from
one of the boxes labeled “Point Event”, “Limitless Event”, etc. in figure
4.3.1 and appropriately places it on the time scale. The time scale
appears near the center of figure 4.3.1. The user can modify or change
the position of the icon/icons on the time scale. The scale represents a
12-hour time period between 12 a.m. and 12 p.m. The minimum unit of
time on the scale is 15 minutes, which corresponds to 0.25 centimeters
on the ruler. The smallest unit of time that can be represented on the
scale is called a grid interval.

In order to select an icon, the user points and clicks on the desired
icon, which can then be dragged along with the mouse pointer to any

position on the time scale. The icon may be positioned at any of the grid
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intervals. The user may modify the position of the icon on the time scale
by pointing and clicking on the icon and dragging it along with the
mouse pointer to a new position.

It is important to note that an icon can only be positioned on the
time scale and it becomes invisible if the user tries to place it at any
other location on the canvas. As a visual cue, clicking on an icon will
change its color to red, which indicates that it is currently selected by the
user. Icons are drawn to resemble the temporal extent that they
represent.

After entering the current event, the user clicks on the “Continue”
button to add another event. Finally, clicking on the “Done” button
closes the current window, saving the details to a file and control is
transferred back to the main application window. As the name suggests,
the “Cancel” button aborts the current operation, clears the screen and
takes the control back to the “Event Name” text box. The “Help” button
provides an online help facility for the current screen and guides the user
during the processing sequence. This helps the user to learn the
interface, and lessens the probability of undesired results.

The following explains the various categories of information that
can be represented using the symbolic icons.

o Point event: It represents those events which occur at precise points.

For example,

John called at 2:30 a.m., 4:45 a.m., 6:15 a.m. and 12 p.m. (1)
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This can be represented using the “Point Event” by placing the icon at
the appropriate time points on the scale, as shown in figure 4.3.3. It
is important to note that the user selects the “Point Event” icon four
times in order to position it at four different locations - 2:30 a.m.,

4:45 a.m., 6:15 a.m. and 12:00 p.m.

Figure 4.3.3 Point Event.

e Limitless Event: This icon represents an event that started at some
unknown time in the past and continues until an unknown time in
the future. For example,

It was raining throughout the day. (2)

(Note that in this example, “day” represent a 24 hour time period.)
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This event possibly started before 12 a.m. and ended after 12 p.m. but
was definitely true between 12 a.m. and 12 p.m. When the user
places the “Limitless Event” icon on the time scale, it automatically

configures itself to cover the entire scale, as shown in figure 4.3.4.

Entering Information

Figure 4.3.4 Limitless Event

e Fixed Event: It represents those events, which have a precise starting

and ending point. For example,

I went jogging between 6 a.m. and 8 a.m. (3)
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“Jogging” has a precise starting and ending point and is represented
using the “Fixed Event” icon. The above event is true between 6 a.m.
and 8 a.m. To position it on the time scale, the user points and clicks
on the “Fixed Event” icon and drags it to the appropriate position on

the time scale.

Entering Information

Figure 4.3.5 Fixed Event
The user can modify the length of this icon on the time scale
by clicking on a small square attached to the icon (one is shown at 8
a.m. in figure 4.3.5) and dragging it with the mouse. This configures
the “Fixed Event” icon to a desired length. As a visual cue, the small

square attached to this icon changes its color to red, when the user
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brings the mouse pointer over it. The minimum time interval that this
icon can represent is 15 minutes.

e Fixedleft Event: This icon represents an event which starts at a

known fixed point and continues into the future. For example,

The basketball game started at 9 a.m. and finished in the afternoon.
(4)

This event is definitely true between 9 a.m. and 12 p.m. and it ends

after 12 p.m. The user places the left end of the “FixedLeft Event” icon

at 9 a.m. on the time scale and the right end of the icon automatically

covers the rest of the scale indicating that the event continues into the

future as shown in figure 4.3.6.

Entering Information

Figure 4.3.6 FixedLeft event
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o FixedRight Event: An event that started at some unknown time in the

past and has a fixed ending point is represented by this icon. For
example,
The Snow storm started last night and ended today at 10 a.m. (5)
It is important to note that the event started at some point before 12
a.m. and continued till 10 a.m. Event “Snow storm” was definitely
true between midnight and 10 a.m.

The user places the right end of the icon at 10 a.m. on the time
scale and the left end automatically covers the rest of the scale. It
indicates that the event started sometime before 12 a.m. and

continued till 10 a.m. as shown in figure 4.3.7.

Entering Information

Figure 4.3.7 FixedRight Event
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It is possible to represent events that require the use of more than one

type of symbolic icon. For example,

The telephone switch had its peak load at 4 a.m., 6 a.m., 10 a.m.

11:30 a.m. and between 10:00 till 11:30 a.m. (6}

Example (6) requires the use of “Point Event” and “Fixed Event’ to

capture the event details as shown in figure 4.3.8.

Entering Information

Figure 4.3.8 Point Events and Fixed Event
The user selects the “Point Event” icon four times in order to

position it at four different locations: 4 a.m., 6 a.m., 10 a.m., 11:30 a.m.
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The “Fixed Event” icon is selected once and positioned between 10 a.m.
and 11:30 a.m.

Example (6) represents the case where the event occurred between 10
a.m. and 11:30 a.m. including the end points. This is a closed interval.
Figure 4.3.5 represents the event “I went jogging between 6 a.m. and 8
a.m.” which is definitely true between 6 a.m. and 8 a.m. No commitment

is made at the end points. We represent this event with an open interval.

e Querying the system:

The user can perform the following queries:
1. Is an event true at the given time ?

2. What is true about an event ?

The screen shown in figure 4.3.9 is used to query information. The
layout of the query window is similar to the enter information window.
Providing consistency among different windows is essential to the design

of the graphical user interface.
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Guerying the System

Figure 4.3.9 Screen for Querying the System

“Select Event” is the label for the dropdown event list box shown by
a button with a downward arrow sign. The user can view the list of
events by clicking on this button as shown in figure 4.3.10. An event is
selected from the list by pointing and clicking on it. The user confirms

his/her selection by clicking on the “OK” button.

46



CHAPTER 4. SYSTEM OVERVIEW

Cuerving the Systemn

Figure 4.3.10 Query Screen with dropdown list

To query the system about an event, the user selects and positions
the appropriate icon on the time scale and clicks on the “Query” button.
The system displays the result(s) of the query in a separate dialog
window. As the name suggests the “New Query” button allows the user
to perform a new query by clearing the screen and returning control to
the “Select Event” dropdown list box. The “Exit” button closes the
current window and transfers control back to the main application
window. The “Help” button provides an online help for the current screen
and guides the user during the processing sequence.

When the user clicks on the “Query” button, Tcl opens a pipe. This
pipe is used to send properly formatted the query commands to ECLPSe,

The ECLPSe inference engine interacts with the knowledge base, which is
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the repository of facts, to solve the queries requested by the user. Output
from the inference engine is written to a file, which is parsed by the

translator and the results are displayed in a dialog window.

Result

” Flgure 4 3 11 Querymg PomtEvent
We conclude with a few query examples. The first one is:
e John called at 2:30 a.m., 4:45 a.m., 6:15 a.m. and 12 p.m.

The event name for this event is “Phone calls” and is true at 2:30 a.m.,
4:45 a.m., 6:15 a.m. and 12 p.m. The user selects this event from the
dropdown event list box by clicking on it and confirms his/her selection
by clicking on the “OK” button. The user selects the “Point Event” icon
four times and places it at the following four positions on the time scale:

2:30 a.m., 4:45 a.m., 6:15a.m. and 11 a.m.
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Clicking on the “Query” button initiates the query procedure and
the system displays the result of the query in a dialog window as shown
in figure 4.3.11. This query results in “No”. The user should place the
“Point Event” icon at 12 p.m. instead of 11 a.m. for the query resulit to be

true.

Figure 4.3.12 shows another query example.

¢ [t was raining throughout the day.
The event name for this event is “Rain”, the event description is “It was
raining throughout the day”. This event possibly started before 12 a.m.
and ended after 12 p.m., but was definitely true between 12 a.m. and 12

p-m.

The user confirms his/her selection by clicking on the “OK” button
and then positions the “Fixed End” icon between 4 a.m. and 7 a.m. The

query procedure is initiated by clicking on the “Query” button.

As shown in the figure 4.3.12 the query results in “True”. It means the

event “Rain” is true between 4 a.m. and 7 a.m.
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— I

Result

Figure 4.3. 12 Querying Limitless Event
The user can find out what is true about any event by selecting an
event from the dropdown list box and confirming his/her selection by
clicking on the “OK” button. Finally, clicking on the “What’s True” icon,
displays a dialog window showing the time at which the event is true.

For example, the user selects the event “Phone calls” from the
dropdown list of events and clicks on the “OK” button to confirm the
selection. The user then clicks on the “What’s True” icon and the system
displays the results of the query using the dialog window shown in figure
4.3.13. The event “Phone calls” is true at points 2:30 a.m., 4:45 a.m.,

6:15 a.m. and 12 p.m.
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Results

We can also do open and closed interval queries. Recall example (3):

e | went jogging between 6 a.m. and 8 a.m.

The event name for this event is “Jogging” and is true over the open
interval between 6 a.m. and 8 a.m. The “Fixed Event” icon is positioned
between 6 a.m. and 8 a.m. on the time scale along with the “Point Event”
icons at 6 a.m. and 8 a.m. respectively, as shown in figure 4.3.14. This
makes the event “Jogging” true in a closed interval. The user initiates the
query procedure by clicking on the “Query” button. The query results in
“No” because the event “Jogging” is not true in a closed interval between

6 a.m. and 8 a.m.
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| Flgure43 14 PomtEvent and Fixed Event (closed mterva.l) |

Let’s perform the same query again over the open interval between
6 a.m. and 8 a.m. The “Fixed Event” icon is positioned between 6 a.m.
and 8 a.m. on the time scale as shown in figure 4.3.15.

The user initiates the query procedure by clicking on the “Query”
button. The query results in “True” because the event “Jogging” is true

between 6 a.m. and 8 a.m.
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Resul?

e ——— e —

Figure 4.3.15 Point Event and Fixed Event (open interval)

4.4 System Database

Information about the events is stored in the database file and can
be viewed by the user. The main application window is shown in figure
4.4.1 with its “Options” menu pulled down.

The “Options” menu provides the following choices: “View

Database”, “Colors Used” and “Symbols”.
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welcome, el

Figure 4.4.1 Main application window
At any point during the processing sequence, the user may access

the database.

Event Details

Figure 4.4.2 Event Details
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Choosing “View Database” from the “Options” menu opens a dialog
window showing “Event Name”, “Associated Color” and “Event
description” in a tabular form as shown in figure 4.4.2.

Similarly, choosing “Colors Used” from the “Options” menu opens a
dialog window showing the colors currently in use. The user can scan the
colors along with their hexadecimal values. The color window has a
vertical and horizontal scroll bar for easy navigation as shown in figure

4.4.3

Colors Used

Figure 4.4.3 Colors Used
Clicking on the “Symbols” under the “Options” menu opens a window

that displays a list of symbols used. Each symbol is displayed along with

its name and meaning as shown in figure 4.4.4.
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Syimbols

Figure 4.4.4 Symbols

These dialog windows help keep the user updated about the state
of the system.

There is an on-line tutorial that explains the complete working of
the graphical user interface for the temporal expert system shell. It helps
the user to learn the interface, and lessens the probability of undesired

results.
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Chapter 5

Inference engine and Knowledge base

Again I saw that under the sun the race is not to the swift, nor the battle to
the strong, nor bread to the wise, nor riches to the intelligent, nor favor to
the man of skill; but time and chance happen to them all.

- The Bible, Ecclesiastes, 9

This chapter discusses the inference engine and knowledge base.
The inference engine, written in ECLPSe, is the backbone of the system.
The inference engine interacts with the knowledge base, which is the

repository of facts, to solve the queries requested by the user.

5.1 Inference engine

Our inference engine consists of ECLPSe and rules for

solving queries about interval and point based information [Good92].
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Interval based information is represented using the integral rule.
integral (a, b, £, x) is true if and only if the integral of f from a to b is x.
We use a limited version of the integral rule which can be viewed as
the measure of the duration of truth of f over the interval (a,b). For
example, “jogging” is true throughout the interval (0,10) is written as
integral (0,10, jogging, 10) and “jogging” is true for half the time is
integral (0,10, jogging,5) . Note that in the latter case, “jogging” may
not have been true over a single sub-interval of length 5.

Information true at an isolated point is represented using the
point rule. point(t,f,x) is true if and only if f(t}=x. For example,
“running” is true at time 5 is written as point (5, running, 1) . The “1”
represents “true”.

For the examples that follow in this section, assume the knowledge

base consists of the following facts:

point (5, running,1).

integral (0,10, jogging,10).

We conclude this section with a description of the rules used to

implement the point and integral relations.
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Point relations:

pt(T,le) - (1)
point(T,F,X).

pt(T,F,1) :- (2)
A #< T,
B #> T,
C #= B-A,
integral(aA,B,F,C).

Figure 5.1 Point relations

The pt (T, F,X) rule shown in figure 5.1 (1), is true if there is a
corresponding fact point (T, F, X) in the knowledge base. For example, to
find out if the event “running” is true at 5, the inference engine checks
the knowledge base for the fact point (5, running,1). On finding the
above fact, it successfully satisfies rule (1) and returns with “Yes”.

To determine if F is true at an isolated point T, we can also look for
an interval (A,B) which contains T and over which F is true throughout.
This strategy is captured by the second rule in figure 5.1. For example, to
find out if the event “jogging” is true at 5, the inference engine checks the
knowledge base and finds integral (0,10, jogging, 10) .
integral (A,B, jogging, C)is unified with integral

(0,10,jogging, 10) . At the given point T=5, the ECLPSe inference
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engine successfully satisfies rule (2) and therefore the event “jogging” is
true at point S.

Integral relations:

int(A,B:F,X) Hi (3)
integral (A,B,F,X), 1!.

int(A,B,F,C) :- (4)
X #i<= A,
Y #>= B,
Z #= Y-X,

integral (X,Y¥,P,Z),
c #= B-A.

int(A,B,F,C) :- (5)
X #<= A,
Y #> A,
Y #< B,
Z #= Y-X,
integral(X,Y,F,2),
int(¥,B,F, Temp),
C #= Y-A+Temp.

Figure 5.1.1 Integral relations

Interval based information is solved using the integral rules in

figure 5.1.1. The int(A,B,F,X) rule shown in (3), is true if there is a

corresponding fact integral(a,B,F,X) in the knowledge base. For
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example, to find out if the event “jogging” is true between the interval O
and 10, the inference engine checks the knowledge base for the fact
integral (0,10, jogging, 10) . On finding the above fact, it matches it
with the goal in (3) and returns with “Yes”.

The inference engine uses the rule int (A,B,F,C) shown in (4), to
find out if an event F is true over a super-interval (X,Y) of (A,B). It is
important to note that this integral rule checks the truth-value of an
event F over a closed interval. An event F is true over the interval (A,B), if
there exists an integral(X,Y,F,Z), such that its lower limit X is less than
or equal to A, its upper limit Y is greater than or equal to B, the
difference of X and Y is Z and the difference of A and B is C.

For example, event “jogging” is true throughout the interval (0,10).
To find out if “jogging” is true between the interval (5,8), the inference
engine checks the knowledge base for integral (0,10, jogging, 10).
For the given interval (5,8), the ECLPSe inference engine successfully
satisfies rule (4) and therefore the event “jogging” is true between (5,8).

The rule int(A,B,F,C) shown in (5), implements the following
additive property of integrals:

[P f(x) dx = o f(x) dx + [cb f(x) dx.

integral(10,11, jogging,1).

For example, the event “jogging” is true between [0,10] and [10,11].

The inference engine uses the rule int(A,B,F,C) in (5) to prove that
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“jogging” is true between [0,11]. Note that we use “int” and “integral” in
the code in order to distinguish between the rules and the facts in the
knowledge base. This helps to avoid infinite loops. Similarly for “pt” and

“point”
5.2 Knowledge base

The point and the interval rules are static. On the other hand, the
knowledge base is dynamic because facts are added as a result of user
interaction.

The user enters the event name, event description, color and
temporal information for every event into the system. The translator
maps the information entered by the user to a logical form and stores it
as facts in the knowledge base. The unique color that represents each
event is used to index that event. Every fact in the knowledge base

contains the following information:

& Unique color that represents the event.

o Temporal information associated with that event.

The following example illustrates what gets stored in the knowledge

base as a result of the translation from the graphical to the logical form.
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Entering information

Figure 5.2 Fact representation in the knowledge base

¢ Mary will be in her office at 8 a.m. and between 10 a.m. and 11 a.m.

This event is represented by positioning a “Point Event” icon at 8 a.m.
and “Fixed Event’ icon between 10 a.m. and 11 a.m. as shown in figure
5.2.

The translator maps the event details entered by the user into the

logical formm and stores it in the knowledge base as the following facts:
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point (8.0,bc7a60,1) .

integral (10.0,11.0,bc7a60,1).

Note that “bc7a60” is the code for the color associated with the event.
Every time the user enters information, new facts are added to the
knowledge base.

The inference engine and the knowledge base constitute the back
end of the system and are transparent to the user. Due to the loose
coupling between the implementation and the interface, we can change
the underlying implementation without changing the interface. This
feature makes the design more robust. New features can be easily added

to the existing system.
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Chapter 6

Evaluation of the GUI

It were not best that we should think alike; it is difference of opinion that

makes horse races.
-Mark Twain

The designer is faced with the task of estimating the effectiveness
of the user interface. A complete evaluation of the user interface design
is an expensive process. It requires the support of cognitive scientists
and trained technicians in graphical design. It involves designing and
performing a number of statistically significant experiments with typical
users. This type of experiment may be economically feasible for large
projects, but for comparatively small development projects, this type of
experiment is unrealistic. =However, user interface evaluation is an
important part of the design process and it should not be ignored, but
should be scaled to suit the particular design. These types of evaluations
may be less reliable but they serve as a measure of user preferences and

to detect particular error prone operations.
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An evaluation technique that can be used is an observation

process. The user is assigned specific tasks to carry out, and the results

gathered by observing their interaction with the interface. This is a form

of diagnostic analysis and is a subjective method of evaluation. Laurel

[Laub90] proposes several steps to follow when doing this type of

evaluation:

e Set up the observation: This involves preparing the questions or tasks

that the user will be doing in the observation. These tasks should
emphasize all the important parts of the interface being evaluated.
Create a realistic situation for the observation; that is, set up the
environment similar to one, which would be used normally by the
user.

Recruit users for the evaluation: In recruiting users, make sure that
the subjects have approximately the same experience level as typical
users of the system. Also they should not be familiar with or have
pre-conceived notions about the product.

Describe the purpose of the observation: Set the users at ease by

stressing that they are involved in a design process and emphasize
that it is the product that is being tested, and not the skills of the
users.

User’s claim: Tell the user that he/she can quit anytime.
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e Explain how to_think aloud: Ask users to say what comes to mind

when they work. Laurel [Laub90] suggests that by listening to users
talk and plan, the administrator will be able to examine the user’s
expectations of the product as well as their intentions and problem
solving strategies.

e Demonstrate the equipment to be used: Perform a demonstration of

the equipment that the user will use during the evaluation. This
allows the user to become familiar with the equipment.

e Explain that help will not be provided: It is important that the

administrator allow wusers to work with the product without
interference or extra help. This is the best way to observe how users
really interact with the product. If there is on-line help available, then
point this out to the user, if it has not already been noticed.

e Describe the tasks and introduce the product: Describe to the user

the overall function of the product and explain what each task
requires. If a demonstration of the product is required beforehand,
make sure that something to be tested is not demonstrated.

e Ask the user to voice questions before the evaluation begins: The user

should be given time to browse through the interface for a set amount
of time and ask general questions before the evaluation begins.

e Conclude the observation: After the observation is over, re-explain to

the user the reason for the observation and answer any remaining
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questions. Also provide some form of user satisfaction questionnaire

to obtain the users’ overall opinion of the product.

6.1 User Evaluation

The evaluation of the temporal expert system shell’s user interface
is based on the observation process outlined above. The user is given
tasks to perform using the functions of the user interface. These tasks,
presented in figure 6.1, cover all the important aspects of the user
interface: entering information, querying the system, and general tasks.

When entering information, the user enters the event details, picks
a color for the event and adds terﬁporal information for the event by
positioning the required icon on the time scale. When querying the
system, the user performs queries using two methods:

1. Is an event true at the given time ?
2. What is true about an event ?

During the general tasks section of the evaluation, the user verifies
the database for the total number of events and prints the active
database file.

As the user is performing these tasks the evaluator uses an
observation form (figure 6.2) to record the results of the evaluation. To

categorize the user’s skills, information is gathered pertaining to a user’s
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experience with computers and windows environment. For each task

performed, the following information is recorded:

The time it took to perform a task: This information is used to

determine the rate at which the user learnt the user interface
procedures.

The_type of help required by the user: This information determines the

ease with which the user learns the interface, and whether or not on-
line help is being used.

Problems the user encounters: This information is used to determine

the user’s understanding of the interface and whether the functions of
the user interface are properly defined.

The user’s comments: This information gives the user’s satisfaction

with the interface functions, and features that they think should be
included in the interface.

General observations: These are observations made by the evaluator

about the user’s interaction with the interface.
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Part 1: Entering the Information

Enter the following event details:

1.

Part 2:

4.

Event Name: Meal Schedule.

Event Description: Tim had breakfast at 8 a.m. and lunch at 12 p.m.
Pick Color: Red=60, Green=120, Blue=85.

Place one “Point Event” icon at 8 a.m. and another “Point Event” icon

at 12 p.m.

Event Name: Homework.

Event Description: Henry did his homework between 7 a.m. and 9
a.m.

Pick Color: Red=50, Green=100, Blue=50.

Place the icon “Fixed Event” between 7 a.m. and 9 a.m. on the time

scale.

Event Name: Snow.

Event Description: It was snowing throughout the day.
Pick Color: Red=95, Green=200, Blue=175.

Place the icon “Limitless Event” on the time scale.

uerving the System

Find out the time points at which the event “Meal Schedule” is true?

Select the event “Jogging” from the event list and find out if this event
is true between 10 a.m. and 11 a.m.? Also, check if the event is true
at point 10 a.m. and point 11 a.m. on the time scale? (Note: Event
details for “Jogging” already exist in the Knowledge base).

Figure 6.1 Evaluation Tasks
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6.Find out at what time the event “Phone calls” is true and verify the results.
What are the steps involved in verification?

7. Is the event “Snow” true between S a.m. and 8 a.m.?

Part 3: General tasks

8. How many events are currently stored in the database?
9. Print the active database file.

10. Is “Black” one of the colors used to represent an event.
Note: Black has a hexadecimal value of #000000.

Figure 6.1 Evaluation Tasks cont’d
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Observation Form

User Information

1. Experience with Computers.

___ Novice ____Intermediate ___Expert
2. Experience with Windows.

___ Novice ___Intermediate ___ Expert
3. Experience with Unix.

___Novice ____Intermediate —— Expert

Task Information

4. Task Number:

4. Time taken to perform the task:

S. Did user require help: Yes No

—— W com—

If yes, what kind of help:

6. Problems with interface:

7. Comments user made:

8. General Observations:

Figure 6.2 Observation Form
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6.1.1 Results of the Evaluation

There were ten participants in the evaluation, and their computer
expertise was categorized as novice, intermediate or expert. The number
of participants in the individual categories is represented in figure 6.3.
This characterization was based on the users’ knowledge and experience
with computers and the windowing environment. This user population
was chosen because the interface is targeted towards novice and
intermediate users. The expert users were chosen to obtain the opinion
of individuals who have had experience with similar products and could
give informed ideas about the interface.

Each participant in the evaluation was introduced to the interface,
and the novice users were given a demonstration on how to use the
window environment on the workstation, and a brief summary on how to
manipulate windows in the interface and the widgets using the mouse.

The following general steps were given in the introduction along

with the steps that were outlined for this evaluation process:

» Explain how to use on-line help.

& Explain the structure of the interface. The user was instructed
that all the major functions could be reached through the main
window, and that each function performed in the interface is

done through a specific window.
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e Explain that the only help given will be to interpret the tasks
and inform them of the type of function required to perform the

task.

evaluation
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Figure 6.3 User population for the evaluation

6.1.1.1 Observations

Task 1: Enter the event details for the event “Meal Schedule”.

As it was the first task, 70% of the users had to be informed that to
position an icon on the time scale, the user has to single click on the icon
and with the mouse button-1 depressed, drag the icon to a specified
position. The expert users were easily able to pick the color for an event

by filling in the numerical values for red, green and blue. Novice users
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took more time to select the color as they used the mouse to point and
select the red, green and blue values from the color scales.
This task took the longest for all users to perform, since they were

learning to navigate the interface.

Task 2: Enter event details for the event “Homework”.

90% of the users understood how to enter the event name, event
description and pick a color. The main complaint that the experienced
users had was that tabbing from one text field to another was not
functioning. Hence, mistakes were made in typing the values into the
correct field. Also the process of selecting, positioning and configuring

the “Fixed Event” icon on the time scale was not obvious to the users.

Task 3: Enter event details for the event “Snow”.

80% of the users were able to complete this task easily. The novice
users took more time to select and position the “Limitless Event” icon on
the time scale. Users complained that there was no way to delete/change

the information once entered into the database file.

Task 4: Querying the system for the event “Meal Schedule”.
Once the use of the “What’s True” query icon was explained to the
users, all of them were able to find out the time points at which the event

“Meal Schedule” is true.
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Task 5: Querying the system for the event “Jogging”.
60% of the users were able to execute the query. However, 40% of
the users had to be told that it is possible to position one type of icon

over the other.

Task 6: Querying the system for the event “Phone calls”.

All the users were able to find out the time points at which the
event “Phone calls” is true. 80% of the users had to be explained the
meaning of the task in detail. Users found the verification task to be the

most difficult of all the queries.

Task 7: Querying the system for event “Snow”.

This query was easily performed. However, one user inquired
whether he could place “Point Event” icons at all points between the time
interval 5 a.m. and 8 a.m. to check if the event is true. The meaning of

“Fixed event” icon was explained later to the user.

Task 8: Finding the total number of events in the database.
All the users were able to accomplish this task. 40% of the users
found an alternative method of doing this task by choosing “Show

database” under the “Options” menu.
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Task 9: Printing the database file.
Users had to be explained that the print option by default prints
the active database file. Everyone found it relatively easy to print the file

after the explanation.

Task 10: Finding out if “Black” was one of the colors used for an event.

All the users easily performed this task.

6.2 User Satisfaction Evaluation

Chin et al [Chap90] mention that user acceptance of a system is a
critical measure of the system’s success. Although a system may be
evaluated favorably on every performance measure, the system may not
be used very much, because of the user’s dissatisfaction with the system
and its interface.

The questionnaire that will be used to perform this part of the user

evaluation will be based on the QUIS 5.0!(shown in figure 6.4).

! Questionnaire for User Interface Satisfaction developed by the Human-Computer Interaction Laboratory
at the University of Maryland [Chap90]).
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User Satisfaction Questionnaire

1. Overall reactions to the user interface.

a) terrible wonderful
0 1 2 3 4 S 6 7 8 9

b) difficult easy
0 1 2 3 4 5 6 7 8 9

c) rigid flexible

0 1 2 3 4 5 6 7 8 9
2. Organization of information.

confusing very clear

0 1 2 3 4 S 6 7 8 9

3. Sequence of screens.
confusing very clear

0 1 2 3 4 S 6 7 8 9

4. Use of terms throughout system.
inconsistent consistent

0 1 2 3 4 S 6 7 8 9

S. Computer terminology (icons) related to task you are doing.

never always

0 1 2 3 4 5 6 7 8 9

Figure 6.4 User Satisfaction Questionnaire
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10.

11.

Messages on screen which prompt user for input.
confusing clear

0 1 2 3 4 S 6 7 8 9

Computer keeps you informed about what it is doing.
never always

o 1 2 3 4 S 6 7 8 9

Error Messages.
unhelpful helpful

0o 1 2 3 4 S 6 7 8 9

Learning to operate the user interface.
difficult easy

0 1 2 3 4 5 6 7 8 9

Exploring features by trial and error.
difficult easy

0 1 2 3 4 S 6 7 8 9

Remembering use of commands.
difficult easy
0 1 2 3 4 S 6 7 8 9

Figure 6.4 User Satisfaction Questionnaire cont’d
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13. Tasks can be performed in an obvious manner.
never always

0 1 2 3 4 S 6 7 8 9

14.  Correcting mistakes.
difficult easy

0 1 2 3 4 5 6 7 8 9

15. Experienced and inexperienced users needs are taken into
consideration.
never always

0 1 2 3 4 S 6 7 8 9

Figure 6.4 User Satisfaction Questionnaire cont’d
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6.2.1 Results of the user satisfaction questionnaire

Results of user satisfaction questionnaire

| Mean f
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Figure 6.5 Results of the User Satisfaction Questionnaire

Figure 6.5 represents the results of the user satisfaction
questionnaire shown in figure 6.4. The users responded to the
questionnaire after completing the evaluation tasks. From figure 6.5 we
see that the means vary by a small amount across questions and the
standard deviations are low.

The two highest standard deviations occurred in question number
S, which dealt with recognizing icons, and question number 14, which
dealt with correcting mistakes. In question number 5, a possible reason
for this is that the user either likes working with the icons, or thinks it is

inconvenient to remember the functionality of each icon. In question

81



CHAPTER 6. EVALUATION OF THE GUI

number 14, a possible reason is that experienced users make more

mistakes in typing, therefore they have more mistakes to correct, while

novices are much more careful in checking that the data was correct

before adding it to the database file.

6.3 Conclusions from the observations

The conclusions that can be made from these observations are:
There should be tabbing provided between fields, since users find it
more natural when typing to use the tab key instead of having to

move from the keyboard to the mouse.

o There should be either an up front description of icons, or some

facility other than on-line help that notifies the user of the functions
of icons. However, icons help users learn the functions of the
interface more easily, since they do not have to remember commands,
but can instead use recognition.

On-line help is very useful in explaining processes that are not

obvious to users.

o The consistency in the layout of the windows and the similarity

between “Entering Information” and “Querying the system” screens

helped users to rapidly learn the functions of the interface.

o There should be immediate feedback to the user about the latest

action performed. It helps in deciding the next step.
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Changes to data before writing to the database file should be easier in
the window where the data is being added, so that the user does not
have to delete/change the database file. There should be a means for
modifying the data already entered into the database file.

User actions are unpredictable, it is useful to provide a method of

undoing an action or an “UNDO” button.

6.4 Conclusions from the questionnaire

The conclusions drawn from the results of the user satisfaction

questionnaire are:

The general reaction to the interface was favorable, although the
flexibility was not highly regarded.

Icons are only appreciated by some users, hence an alternative should
be provided.

The error messages are adequate and useful in helping the users to
perform the correct procedures.

Learning to operate the interface is simple and straightforward.
Understanding the functionality takes time.

The on-line help is beneficial to the user.

The interface can be used by both novices and experienced users
efficiently.

Correcting mistakes should be as easy as possible.
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6.5 Modifications to the GUI

Following the results of the user evaluation, several changes were
made to the user interface to reflect user preferences and to improve the
structure:

e In the “Entering Information” window, a tabbing function has been
provided for easy movement from one text box to another. Now, the
user can either use the keyboard or mouse pointer to move from one
field to another.

e Labels have been added to all the icons used for entering temporal
information. This will help the user in identifying the icons.

e Whenever the user points and selects an icon, the icon changes its
color to red, giving a visual cue to the user that the icon is currently
selected. After the user positions the icon on the time scale, the icon
takes the color of the event that it represents.

e In “Querying the System”, the “What’s True” icon changes its color to
blue when the user clicks on it. This gives feedback to the user that
the query operation has been initiated.

¢ A window explaining the use and functionality of all the icons used to
represent temporal information has been added to the main
application window. This will help the user in selecting the right icon

for an event.
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Chapter 7

Conclusion

Never remind someone of a kindness or act of generosity you have shown

him or her. Bestow a favor and then forget it.
-Little Book on Wisdom.

The aim of this thesis was to present a logic independent graphical
user interface (GUI). The main research challenge was the definition of
the GUI. The GUI is developed using the principles of user interface
design and implemented in a way that it is easy to learn, use, efficient
and effective. The GUI allows the user to enter, query, and represent
temporal information using color-coded symbols. The user does not have
to be familiar with the particular logic used by the implementation.

Following the design of the interface and the background research

that was required the following conclusions were drawn:
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e The user interface design is crucial to the success of a product. The
user interface defines the quality of a product and the ease of use and

learning of the system.

e The three most important principles in user interface design are:

1. The interface should be designed to suit the needs and the abilities
of the anticipated user. Users should not be forced to adapt to an
interface because it is convenient to implement or because it is
suited to the system’s designer.

2. User interfaces must be consistent. Consistency should be
maintained within a system and across subsystems.

3. User interfaces should have on-line help. Help should be accessible

and context sensitive.

e Object-oriented concepts have made a huge impact on user interfaces.
Designers are applying object-oriented concepts to the design

presentation and the integration of user interfaces.

o The GUI to the temporal expert system allows the user to successfully

enter and query temporal information using the icons and symbols.

e The temporal expert system shell uses various icons such as “Point

Event”, “Limitless Event”, etc. to capture temporal information. The
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model has been successful with the small subset of the temporal

information.

¢ Meaningful icons can be added to the system to handle more

categories of events. Logic used is more powerful than the GUI.

e The inference engine and knowledge base of the system are kept

transparent to the user.

e The loose coupling between the implementation and interface makes
the design more robust. One can change the underlying

implementation without changing the graphical user interface.

e The evaluation of a user interface is a valuable process in making the
design decisions that improve user satisfaction and quality of the

interface.

e The user does not have to familiar with the particular logic used by
the implementation. It is easy to use GUI for entering, representing
and querying information compared to using Eclipse and the logic

directly.
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7.1 Future Development
The functionality of the GUI can be improved in several areas:
e Enhance the capabilities of the system to handle more categories of
events. For example, include icons to handle the following events:
¢ John played squash and tennis for equal amounts of time
between 5 p.m. and 7 p.m.

The following icon could represent this event:

A}_-®-1B

@
The length of the line AB represents the time between S p.m. and 7

p-.m. The horizontal bars ® and @ represent the two activities
squash and tennis. The horizontal bars ® and @ have the same
length because squash and tennis were played for the same
amounts of time. Making these bars oscillate between A and B
represents that these activities occurred between 5 p.m. and 7
p.m. The above icon becomes complicated when there are more
than 3 or 4 activities. We conclude that it is not an obvious
problem. One solution could be mixing graphics and text to
capture the event details. The underlying ECLPSe¢ inference engine
has the capability of handling such events.

Another example is:
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¢ Paul ran 1 hour between 12 p.m. and 6 p.m.
e Extend the capability of the system to handie true, false and unknown
information for the events like:
¢ Henry was in Halifax yesterday but he will not be in
Halifax today. We do not know where he will be tomorrow.
e Extend the capability of the system to handle conjunction and
disjunction for the events like:
¢ | was either at Tim Hortons or the Coffee Merchant for
lunch.
¢ Enhance the capability of the system to handle implications for the
events like:
¢ My dog sits whenever [ whistle.
vt, if whistle blows at time t, then dog sits at time t.

vVt point(t, whistle,1) > point(t, dog_sits,1).

e Add a feature to delete or modify the events already entered into the

system.

7.2 Applications

The GUI could be used in scheduling applications. The user enters
the time at which a person is available during the day and system stores
the details in the knowledge base. This information can be used later in

setting up appointments.
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User Manual

welcome.tcl

Figure A.1: Start Window
To start the temporal expert system shell, type in the command:

welcome.tcl

96



APPENDIX A. USER MANUAL

The execution of this command opens a welcome window as shown in
figure A.1. By clicking on the “Continue button”, a window opens which

gives access to the user interface and the tutorial (figure A.2).

welcome.tcl

Figure A.2: Interface Window

To start the interface:

Click on the “Start Shell” button to open the main application window as

shown in figure A.3.

To start the tutorial:
Click on the “Start Tutorial” button to give the user access to the tutorial

functions which are discussed later.
A.1 Using the main window:

The main window acts as a control point for the functions of the

interface.
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application.rcl

Figure A.3: Main application window

A.1.1 File menu:

The File menu provides the following functions:

Create a new file:

1. Click on the “New” button to open the dialog window as shown in
figure A.4. This allows the user to create a new file to save event
details.

2. Enter the name of the file as shown in figure A.4.

3. User clicks on the “OK” button to confirm the file name. The “Cancel”

button aborts the operation.
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Figure A.4: New file window

Open an existing file:

1. Click on the “Open” button to open the dialog window shown in figure
A.S. This allows the user to open an existing file, which will be used to
save event details.

2. Select the type of the file and file name to open.

3. The “Cancel” button aborts the operation. The Directory options menu

allows the user to choose any directory. The user gives his/her

Op'eh

R

confirmation by clicking on the “Open” button.

Figure A.S: File open window
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Save a file:

As the name suggests, clicking on this button saves the current file.

Print a file:

1. The Print button allows the user to print the active database file.
Clicking on the print button opens up a confirm window as shown in
figure A.6.

2. The user can confirm by clicking on the “OK” button. The “Cancel”

button aborts the print operation.

Prin t?'

Figure A.6: Print confirm window.
Exit:

The “Exit” command closes all the windows and ends the application.

A.1.2 Edit menu:

The Edit menu provides the following functions:
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welcome.tcl

Figure A.7: Main window (Edit menu)

Cut, Copy and Paste operations:

They function as expected on text.

Entering information:

Click on “Enter Information” menu option under “Edit” menu to open a
window as shown in figure A.8. This window is used to enter

information.

To enter a “Point Event”:
Consider the following example:

e Mary has a meeting at 10 a.m. (1)

101



APPENDIX A. USER MANUAL

Entering Information

Figure A.8: Entering information

The event name for this event is “Meeting”, the event description is “Mary
had a meeting at 10 a.m.” and the temporal component is that it is true

at 10 a.m.

The steps to enter event (1) are:

1. Enter the event name “Meeting” for this event as shown in figure A.8.
2. Enter the event description in the specified text box.
3. Pick a color by clicking on the “Pick Color” button. This opens a color

window as shown in figure A.9.

102



APPENDIX A. USER MANUAL

4. The user can select a color for the event by filling in the numerical
values for red, green and blue. It is also possible to select a color by
sliding the triangular tab on the color scale for each color.

S. Click on the “OK” button to confirm the selection.

6. Select the “Point Event” icon in figure A.8 by pointing and clicking on
it. Then drag the icon along with the mouse pointer to position 10
a.m. on the time scale.

7. Click on the “Continue” button to add another event.

Figure A.9 Color window

8. The “Cancel” button aborts the operation and takes the control to the
“Event Name” text box.

9. The “Help” button provides help on the “Enter information” screen.

10. Clicking on the “Done” button will close the current screen and will

take the control back to the main window.

To enter a “Limitless Event”:

Consider the following example:
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e The water pump was working throughout the day. (2)

The event name for this event is “Water pump”, the event description is

“The water pump was working throughout the day.” and the temporal

component is that this event possibly started before 12 a.m. and ended

after 12 p.m.

Steps followed to enter event (2) are:

1. Enter the event name “Water pump” for this event as shown in figure
A.10.

2. Enter the event description in the specified text box.

3. Pick a color by clicking on the “Pick Color” button. This operation is
explained above.

4. Click on the “OK” button to confirm the selection.

S. Select the “Limitless Event’ icon by pointing and clicking on it. Then
drag the icon along with the mouse pointer to position it on the time
scale. When the user places the “Limitless Event” icon on the time
scale, it automatically configures itself to cover the entire scale as
shown in figure A.10.

6. Click on the “Continue” button to add the another event.
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Entering Information

Figure A.10 Limitless Event

To enter a “Fixed Event”:

Consider the following example:

e Henry was watching TV between 8:30 a.m. and 10 a.m. (3)

The event name for this event is “Watching TV”, the event description is
“Henry was watching TV between 8:30 a.m. and 10 a.m.” and the
temporal component is that the event is true between 8:30 a.m. and 10

a.m.
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Figure A.11 Fixed Event

Steps followed to enter event (3) are:

1. Enter the event name “Watching TV” for this event in the “Event
Name” text box.

2. Enter the event description in the specified text box.

3. Pick a color by clicking on the “Pick Color” button.

4. Click on the “OK” button to confirm the selection.
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5.

7.

Select the “Fixed Event” icon by pointing and clicking on it and then
drag it to the appropriate position on the time scale. (In this case,
between 8:30 a.m. and 10 a.m.)

The user can modify the length of this icon on the time scale by
clicking on a small square attached to the icon and dragging it with
the mouse. This configures the “Fixed Event” icon to a desired length
as shown in figure A.11.

Click on the “Continue” button to add another event.

To enter a “FixedLeft Event”:

Consider the following example:

& Sonia started the painting at 10 a.m. and worked on it till late

afternoon. {4)

The event name is “Painting” and the event description is “Sonia started

the painting at 10 a.m. and worked on it till late afternoon.” This event is

definitely true between 10 a.m. and 12 p.m.

We use the “FixedLeft Event’ icon to represent event (4) and the steps

followed are:

1.

2.

Enter the event name “Painting” for this event as shown in figure A.12
Enter the event description in the specified text box.

Pick a color by clicking on the “Pick Color” button as explained in the
previous examples.

Click on the “OK” button to confirm the selection.
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S. Select the “FixedLeft Event® icon by pointing and clicking on it and
then drag it to the appropriate position on the time scale.

6. The user places the left end of the “FixedLeft event” icon at 10 a.m. on
the time scale and the right end of the icon automatically covers the
rest of the scale as shown in the figure.

7. Click on the “Continue” button to add another event.

Entering Information

Figure A.12 FixedLeft Event

To enter a “FixedRight Event”:

Consider the following example:

e The snow storm started last night and ended today at 10 a.m. (5)
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It is important to note that the event started at some point before
12 a.m. and continued till 10 a.m. Event “Snow storm” was definitely
true between midnight and 10 a.m. and therefore we use the “FixedRight

Event” icon to represent it.

Entering Information

Figure A.13 FixedRight Event

After entering the event name, description and color, the user
positions the “FixedRight Event” icon on the time scale. The user places
the right end of the icon at 10 a.m. on the time scale and the left end

automatically covers the rest of the scale as shown in figure A.13.
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Querying the system:

Clicking on the “Query Information” option under “Edit” menu opens a
window shown in figure A.14. This screen is used to query the system.
The user can perform the following queries:

1. Is an event true at a given time ? (A)

2. What is true about an event ? (B)

The following example (3) will be used to perform the query:

e Henry was watching TV between 8:30 a.m. and 10 a.m.

To perform a query using (A):

1. Select the event “Watching TV” from the dropdown list box by clicking
on the down arrow button next to the “OK” button (figure A.14)

2. User confirms his/her selection by clicking on the “OK” button.

3. Configure the “Fixed Event” icon on the time scale between 8:30 a.m.
and 10 a.m.

4. Click on the “Query” button to execute the query. Figure A.14 displays

the result for the query.
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Result

Figure A.14 Query window for Fed Event

To perform a query using (B):

1. Select an event “Watching TV” from the dropdown list box by clicking
on it.

2. Click on the “OK” button to confirm the selection.

3. User then points and clicks on the “What’s True” icon and the system

displays the results of the query as shown in figure A.15.
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Result

i
\

I e

Figure A.15 Query using at’s True

A.1.3 Options menu:

The “Option” menu as shown in figure A.16 provides the following

functions:

View Database:

1. Click on the “View Database” button under the “Options” menu to
open a window that displays event name, event description and color
used for all the events in the database as shown in figure A.17.

2. Click on the “OK” button to close this window.
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welcoime. tcl

Figure A.16 Main window (Options menu).

Event Details

Figure A.17 View Database
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Colors Used:

. Click on the “Colors Used” button under the “Options” menu to open

a window that displays all the colors in use.
Every color is displayed along with its hexadecimal value as shown in
figure A.18. Note that every color in figure A.17 also appears in figure

A.18.

. Click on the “OK” button to close this window.

Colors Used

Figure A.18 Colors Used

Symbols:

1.

Click on the “Symbols” button on the “Options” menu to open a

window that displays a list of symbols used.

. Each symbol is displayed along with its name and meaning as shown

in figure A.19.

114



APPENDIX A. USER MANUAL

3. Click on the “OK” button to close this window.

Svimbaols

Figure A.19 Symbols
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A.2 Tutorial

Temporal Lxpert Systen Help

Figure A.20 Tutorial window

To start the tutorial:

1. Click on the start tutorial button in the Interface Window (figure A.2)
to open the Tutorial Window (figure A.20).

2. This window provides help on various topics such as “Overview of the
System”, “Entering the Information” etc., as shown in figure A.20.

3. The help topics shown above have a “hypertext” behavior.

4. Clicking on the appropriate topic opens the help for that topic in the

same window as shown in figure A.21.
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To get help on Overview of the System:

1. Click on the “Overview of the System” to get help on the overview of
the system as shown in figure A.21.

2. Click on the “Return to Main Menu” to get back to the main menu.
The user can also get back to the main menu by clicking on the
“Original Topics” from the “File” menu. (Figure A.21).

3. Click on the “Close” button to terminate the Tutorial.

4. The Edit menu provides a “copy” function for copying any text from

the Help screen.

System Oveniew

Figure A.21 Overview of the system
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#!/usr/local/bin/wish

#
# Canvas widget with the welcome information

#

proc call main {} {
source interface.tcl
destroy .can

}

# Creates the required font.

font create textfont -family Helvetica -size 27 -weight bold \
-slant italic

set bigf textfont

font create textfontl -family Courier -size 16 -weight bold \
-slant italic

set medf textfontl

font create textfont2 -family Times -size 16 -slant italic\
-weight bold

set namef textfont2

# Canvas with various canvas items.

canvas .can -width 7c¢ -height 1l0c
.can create rectangle .25c .25c 6.75c 9.75c -outline black \

-width 2

.can create text 3.25c 1.5c -font $bigf \
-text "WELCOME" -fill red
.can create line lc 2c¢ 5.5¢ 2c¢ -fill black -width 2

.can create text 3.5c 3c -font Smedf \

-text "To" -fill blue
.can create text 3.5c 4c -font Smedf \

-text "The Temporal Expert " -fill blue
.can create text 3.25c 5c -font Smedf \

-text "System Shell"” -fill blue

.can create bitmap 3c 6c -bitmap grayl2 -foreground black
.can create bitmap 3.5c 6c¢ -bitmap gray25 -foreground black

.can create text 3.5c¢c 7c¢ —-font Smedf \
-text "Designer" -fill maroon

.can create text 3.25c 7.5c -font $medf \
-text "Sharad Sachdev" -fill maroon

button .can.b -text "Continue" -font Snamef \
-command {call_main}
.can create window 3.5c 9c ~window .can.b

pack .can
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#!'/usr/local/bin/wish

#
# Frame widgets within the interface window
#
proc s_shell ( } {
source application.tcl
destroy .f1

}
# Creates the required font

font create txtfont -family Times -size 18 -slant italic\
-weight bold
set namef txtfont

# Frames with buttons.

frame .fl -relief raised -borderwidth 1
button .fl.bl -text "-- Start Shell -~" -font Snamef \

-foreground marocon -borderwidth 5 -command { s_shell}
button .f1.b2 -text "-- Start Tutorial --" -font Snamef \

~foreground maroon -borderwidth 5 -command { source helpdlg.tcl}
button .£f1.b3 -text "-- Close ~-" -font Snamef \

-foreground maroon -borderwidth 5 -command { exit }

pack .fl.bl .f1.b2 .f1.b3 -padx 5 -pady 1 -ipadx 4 -ipady 6 =~-fill both

pack .fl

#!/usr/local/bin/wish
#Creating the application menu

#setting global variable for storing file name.
global nfname
set nfname ""

#

# Create images for toolbar bitmaps.

#

image create bitmap tool new -file ../toolbar/new.xbm
image create bitmap tool_open -file ../toolbar/open.xbm
image create bitmap tool_save -file ../toolbar/save.xbm
image create bitmap tool_cut -file ../toolbar/cut.xbm
image create bitmap tool_ copy -file ../toolbar/copy.xbm
image create bitmap tool_paste -file ../toolbar/paste.xbm

# 0ld way to create a menubar

frame .menubar -relief raised -borderwidth 1
#File menu

menubutton .menubar.file -text "File”™ \

-menu .menubar.file.menu -underline O
pack .menubar.file -side left
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menu .menubar.file.menu

.menubar.file.menu add command -label "New" \

-underline 0 ~command { source file new.tcl }
.menubar.file.menu add command -label "Open..." \
-underline O -command { source filedlg.tcl }

.menubar.file.menu add separator
.menubar.file.menu add command -label "Save"™ \

~underline 0 -command { proc_save }
.menubar.file.menu add command -label "Print" \
-underline 0 -command { proc_print }

.menubar.file.menu add separator
.menubar.file.menu add command ~label "Exit"™ \
-underline 0 -command { destroy . }

#$Edit menu

menubutton .menubar.edit -text "Edit"™ \
-menu .menubar.edit.menu -underline 0
pack .menubar.edit -side left

menu .menubar.edit.menu

.menubar.edit.menu add command -label "Cut" \
-underline 2 -accelerator "Ctrl+x" -command "edit_cut all"
.menubar.edit.menu add command -label "Copy" \
-underline 0 ~accelerator "Ctrl+c" -command "edit_copy all"
.menubar.edit.menu add command -label "Paste" \
-underline 0 -accelerator "Ctrl+v" =-command "edit paste all"
.menubar.edit.menu add separator
.menubar.edit.menu add command ~label "Enter Information" \
-underline 1 -command { source Aruler.tcl }
.menubar.edit.menu add command -label "Query Information" \
-underline 5 -command { source lquery.tcl }

#0ptions menu

menubutton .menubar.options -text "Options" \
-menu .menubar.options.menu -underline 0
pack .menubar.options -side left

menu .menubar.options.menu

.menubar.options.menu add command -label "View Database" \
-underline 0 -command {source show_fact_color.tcl }

.menubar.options.menu add command -label "Colors Used" \
-underline 0 -command {source show_color.tcl }

.menubar.options.menu add command -label "Symbols" \
-underline 0 -command {source show_symbol.tcl}

#Help menu
menubutton .menubar.help -text "Help" \

-menu .menubar.help.menu -underline 0
pack .menubar.help -side right
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menu .menubar.help.menu

.menubar.help.menu add command -label "About..."™ \
-underline 0 -command "help about .menubar"

$Create a faked main area.
label .main -text ""

pack .menubar -side top -fill x -expand true

GRERBHESBGUBERARERGBEBHGHSBASEE
# Toolbar
233223233 EE2232 3383332822232

frame .toolbar -bd 2 -relief raised

# Group for new, open, save.
set frm .toolbar.file group
frame S$frm -bd 0

button $frm.new -image tool new -command {puts new}
button $frm.open -image tool open -command {puts open}
button $frm.save -image tool_save -command {puts save}
pack Sfrm.new $frm.open $frm.save -side left

pack $frm -side left

# Set up short help.
bind Sfrm.new <Enter> \

" _status configure -text {New file}"
bind $frm.new <Leave> \

".status confiqure -text { }"

bind $frm.open <Enter> \

".status configure -text {Open file}"
bind S$frm.open <Leave> \

" .status configure -text { }"

bind Sfrm.save <Enter> \

".status configure -text {Save file}"
bind Sfrm.save <Leave> \

".status configure -text { }"

# Group for cut, copy, paste.
set twidget 1
set frm .toolbar.clip group
frame $frm ~bd 0

button $frm.cut ~image tool_cut -command {edit_cut .}
button $frm.copy -image tool_copy -command {edit_copy .!
button $frm.paste -image tool paste

pack $frm.cut $frm.copy $frm.paste -side left
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bind all <Button-2> { beforePaste %W}

proc beforePaste {textw} (
global twidget
set twidget $textw

}
bind $frm.paste <Button> {edit_paste $twidget}

bind $frm.cut <Enter> \

".status confiqure -text {Cut}"
bind $frm.cut <Leave> \

".status configure -text { }"

bind $frm.copy <Enter> \

".status configure -text (Copy}"
bind Sfrm.copy <Leave> \

".status configure -text ( }"

bind $frm.paste <Enter> \

".status configure -text {Paste}"
bind $frm.paste <Leave> \

"_status configure -text { }"

# Pack second group with X padding to space out.
pack $frm -side left -padx 10

pack .toolbar -side top -fill x

pack .main -ipady 150 -ipadx 250 -expand true -side top

# Status area

label .status -relief sunken -anchor w -borderwidth 1 \
-text "Status"
pack .status -fill x -side bottom

bind .menubar.file <Enter> \

".status configure -text {Operations:New,Open,Save,Print,Exit}"
bind .menubar.file <Leave> \

".status confiqure -text { }"

bind .menubar.edit <Enter> \

".status configure -text \
{Operations:Cut, Copy, Paste, Enter Info,Query Info}"

bind .menubar.edit <Leave> \

".status configure -text { }*

bind .menubar.options <Enter> \

".status configure -text {Operations:View Database,Colors
Used, Symbols}"

bind .menubar.options <Leave> \

" .status configure -text { }"
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bind .menubar.help <Enter> \
".status configure -text {Help}"
bind .menubar.help <Leave> \
".status configure -text { }"

#
# Implementing the cut action for a text widget.

#
proc edit_cut { textwidget } {

# Check if any text is selected in textwidget.
set owner ([selection own]

# clear clipboard
clipboard clear

catch {
set text [selection get]
clipboard append S$text
# Delete selected text.
Sowner delete sel.first sel.last
}
puts "Calling from cut"
puts "textwidget is Stextwidget"

}

#
# Implementing the copy action for a text widget.

#
proc edit_copy { textwidget } {

# Check if any text is selected in textwidget
set owner [selection own]

# clear clipboard
clipboard clear

catch {(
clipboard append [selection get]

}
puts "Calling from copy"
puts "textwidget is Stextwidget"

#
# Implementing the paste action for a text widget.

#
proc edit_paste {textwidget} {

puts "Called from edit_paste"
set owner [selection own]
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puts "textwidget is S$textwidget and owner is Sowner"
catch {

set clip [selection get -selection CLIPBOARD]
}

set idx [$textwidget index insert]
catch {

Stextwidget insert $idx $clip
}

bind . <Control-Key-x> "edit_cut . ;break"
bind . <Control-Key-c> "edit_ copy . :;break”
bind . <Control-Key-v> "edit_paste . ;break"

proc help about {toplevel}l {
tk_messageBox -default ok -icon info -message \
"GUI for Temporal Expert System,
- by Sharad Sachdev" \
-parent S$toplevel -title "About System" -type ok
}

# Printing options

proc proc_print {} (
global nfname
if {$nfname != ""} {
set pmess [tk _messageBox -parent .menubar\
-title {Print?} -type okcancel ~icon warning\

-message\
"Confirm file print."]
if ($pmess == "ok"} {

set command "lpr -P cs-lw4 $nfname"
eval exec Scommand
} elseif {Spmess =="cancel"} (}
} else {
set pmess [tk_messageBox -parent .menubar\
-title {Error} -type ok -icon error\
-message\
“No file to print. Select a file before printing."]
}

#!/usr/local/bin/wish

information and displays the color in the canvas widget.

Procedure file_read given below stores the fact,descrip,
color information in the global variable list_of events,
list_of_descrip variables.

3 3 I I I
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set g .colorwindow
toplevel $g -class Dialog
wm title $g "Colors Used"
wm transient $g

wm geometry S$g +300+300

set filename event_details.dat

global list_of events
global list_ of_ descrip
global list_of_ colors

set data ""
set list_of events ""
set list_of descrip ""
set list_of_colors ""
if {[file readable $filename]} {
set fileid f[open $filename "r"]
while {[eof S$fileid] != 1}
gets $fileid data
set list_of_events [linsert $list_of_events end $data]
gets $fileid data
set list_of colors [linsert $list of colors end $data]
gets $fileid data
set list_of_descrip [linsert $list_of descrip end
$data]
}
close $fileid
}

canvas $g.clr_can -width 12c -height 6c -yscrollcommand \
"$g.v_scroll set” -xscrollcommand "$g.h_scroll set™ \
-scrollregion { 0 0 500 600 }

scrollbar $g.v_scroll -command "$g.clr_can yview"”
scrollbar $g.h_scroll -command "$g.clr_can xview" -orient horizontal

#

#Create the heading

#

font create txtfontl -family Times -size 18 -slant italic \
-weight bold

set namef txtfontl

font create txtfont2 -family Courier -size 10 -slant italic
set namef2 txtfont2

$g.clr_can create text 6c .5c -font $namef -text \

"- Following colors are in use -" -fill blue
#
#Fill in canvas.
#

#Postion paramters x and y
set x1 1; set yl 2
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set len [llength $list of colors]
set len [expr $len-1]
for {set i 0} {S$i < Slen} {incr i} {
set tmp [lindex S$list_of colors $i]
if { $x1 == 13} {
set yl [expr Syl + 2.5]
set x1 1
}
set x2 [expr $x1 + 1]
set y2 [expr Syl + 1]

$g.clr_can create rectangle ${xl}c ${yllc ${x2}lc S(y2ic \
-outline black -£fill $tmp -width 1.25

set ytext pos [expr $y2 + .5]

set xtext pos [expr $x1 + .5]

$g9.clr_can create text ${xtext_pos}c ${ytext posj}c \
-font $namef2 -text $tmp -fill maroon

set x1 [expr S$x1 + 2]

frame $g.frame -relief raised

pack Sg.frame -side bottom -fill x -pady 2m

button $g.frame.b -text " OK " -command {destroy S$g}
pack $g.frame.b -side left -expand 1

pack $g.v_scroll -side right -fill y
pack $g.h_scroll -side bottom -fill x

pack $g.clr_can -side left -expand 1
font delete txtfontl txtfont2

#!/usr/local/bin/wish

This file reads the file which stores the facts,descrip,color
information and displays the same in form of MuliColumn list.

Procedure file read given below stores the fact,descrip,
color information in the global variable list_of_ events,
list_of_descrip variables.

¥ W R IR I IE N

set t .multilist

toplevel $t -class Dialog
wm title $t "Event Details"”
wm transient $t

wm geometry $t +300+300

set filename event_details.dat
global list of events

global list_of_ descrip
global list of colors
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set data ""
set list_of_events ""
set list_of descrip ""
set list of colors ""
if {[{file readable $filename]} {
set fileid (open Sfilename "r"]
while {[eof $fileid] != 1} {
gets $fileid data
set list_of events [linsert $list_of_ events end $datal
gets $fileid data
set list_of_colors [linsert $list_of colors end $data]
gets S$fileid data
set list_of_descrip [linsert $list of descrip end
Sdata]
}
close Sfileid

Tcl script that creates multiple listboxes
with one scrollbar.

o 3k R I

This proc scrolls a number of listboxes all together
from one scrollbar.

The scroll_list holds a list of the widgets
to scroll. This must be a list. The args
hold all the remaining arguments, which
come from the scrollbar. All these are
passed to each widget in the scroll list.

HR M IR I I IR M R SR

proc multi_scroll { scroll_list args } {
global t
# Get info on list of listboxes.
set len [llength $scroll list]

for {set i 0} ($i < Slen} {incr i} {
set temp_list (lindex $scroll_list $i]
eval Stemp_list yview Sargs

#
# Fill in list with various data.
#
proc FillListl { listvar } (
global list_of_events
set len [llength $list_of_events]
set tmp "Event Name"
eval $listvar insert end {($tmp}
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eval Slistvar insert end {$tmp}

for {set i 0} { $i <= $Slen} {incr i} {
set tmp [lindex $list_of_ events $i]
eval $listvar insert end (Stmp}

proc FillList2 { listvar } {
global list_of_colors
set len [llength $list of colors]
set tmp "Associated Color”
eval $listvar insert end (Stmp}
set tmp "-——v———m——c———ee "
eval $listvar insert end {(Stmp}

for {(set i 0} { $i <= Slen} {incr i} {
set tmp [lindex $list of colors $i]
eval $listvar insert end {Stmp}

}

proc FillList3 { listvar } {
global list_of descrip
set len [llength $list_of_descrip]
set tmp "Event Description”
eval $listvar insert end {Stmp}
set tmp "---——-—————m————- "
eval $listvar insert end (Stmp}

for (set i 0} { $i <= Slen} {incr i} {
set tmp (lindex $list_of_descrip $i]
eval S$listvar insert end {S$tmp}

}
# Use a frame around all lists.

frame $t.frame -relief groove ~borderwidth 3
button $t.button -text " OK " -command { destroy $t}

listbox $t.frame.listl \
-borderwidth 1 \
-relief raised \
-selectmode single \
-yscrollcommand "St.frame.scroll set" \

listbox S$t.frame.list2 \
-borderwidth 1 \
-relief raised \
-selectmode single \
-yscrollcommand "$t.frame.scroll set™ \

listbox S$t.frame.list3 \

~-borderwidth 1 \
~-relief raised \
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-selectmode single \
-yscrollcommand "$t.frame.scroll set™ \

# Fill lists with data.
FillListl S$t.frame.listl
FillList2 $t.frame.list2
Filllist3 $t.frame.list3

scrollbar S$t.frame.scroll \
-command \
{ multi scroll ($t.frame.listl $t.frame.list2 S$t.frame.list3} }

pack $t.frame.scroll -side right -fill y

pack $t.frame.listl $t.frame.list2 \
St.frame.list3 -side left

pack $t.frame

pack $t.button

#!/usr/local/bin/wish

#

#This file shows the various symbols which are used in
#the program. This includes symbols for entering and
#querying information.

set u .symbolwindow
toplevel $u -class Dialog
wm title $Su "Symbols"

wm transient $Su

wm geometry $u +300+300

canvas $u.sym_can -width 15c -height 6c -scrollregion { 0 0 600 800} \
-yscrollcommand "Su.v_scroll set”

scrollbar $u.v_scroll -command "Su.sym_can yview"

#

#Create the heading

#

font create txtftl -family Times -size 18 -slant italic \
-weight bold

set namef txtftl

font create txtft2 -family Courier -size 10 -slant italic \
-weight bold

set namef2 txtft2

font create txtft3 -family Courier -size 10

set namef3d txtft3

Su.sym_can create text 8c lc -font $namef -text \
"- Symbols and their meanings -" -£fill blue
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set ¢ $u.sym_can

#

# The following procedures create the symbols on the canvas.

#

W I I I A AR IE IR

rulerMkTab --
This procedure creates a new circular polygon in a canvas to

represent a point event.

Arguments:
c - The canvas window.
X, ¥ - Coordinates at which to create the tab stop.

proc rulerMkTab {c x y} |
set vl [winfo fpixels S$c .3c]
$c create oval [expr $x~5v1/2] [expr $y-$vl/2] [expr Sx+Sv1l/2] \

}

#
#
#
#
#
#
#

[expr Sy+$vl/2] -fill black

rulerMkTabIL --
This procedure creates a new Infinite line item in a canvas.

Arguments:
c - The canvas window.
X, Yy -~ Coordinates at which to create the IL item.

proc rulerMkTabIL {c x y} {
set vl [winfo fpixels Sc 1lc]
$c create line $x Sy [expr Sx+S$v1l] Sy \

}

#

#
#
#
#
#

-arrow both -fill black -width 8

rulerMkTabFE --
# This procedure creates a new Fixed End line item in a canvas.

Arguments:
c - The canvas window.
X, ¥ - Coordinates at which to create the FE item.

proc rulerMkTabFE (¢ x y} {

set vl ([winfo fpixels Sc 1lcj

$c create line $x $y [expr $x+$vl] \
Sy -fill black -width 8

rulerMkTabFL
This procedure creates a new Fixed Left item in a canvas.

Arguments:
c - The canvas window.
X, Yy - Coordinates at which to create the FE item.
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#

proc rulerMkTabFL {c x y} (
set vl [winfo fpixels $Sc lcj
Sc create line $x Sy [expr $x+Svl] \
Sy -fill black -width 8 -arrow last

# rulerMkTabFR

# This procedure creates a new Fixed Right item in a canvas.
#

# Arguments:

$# c - The canvas window.

# x, vy - Coordinates at which to create the FE item.
#

# vl plays an important role in positioning the item.

proc rulerMkTabFR {c x y} {
set vl [winfo fpixels $c 1lc]
Sc create line $x $y [expr $x+S$Svl] Sy \
-fill black -width 8 -arrow first

# rulerMkTabQues
# This procedure creates a new Question item in the canvas.
# Clicking on this tells everything about the selected event

proc rulerMkTabQues { c x y} {
Sc create bitmap 2c 18c -bitmap questhead

}

#
#Fill in the canvas.
#Creates the symbol and associated message window

#

$c addtag well withtag [$c create rect 1.5¢ 3.5¢c 2.5¢ 2.5¢c \
-outline black -fill [lindex [$c config -bg] 41]
$c addtag well withtag [rulerMkTab $c [(winfo pixels Sc 2c] \
(winfo pixels Sc 3c]]
Sc create text 2c 4c -text "Point Event" \
~-font Snamef2 -fill maroon

message Sc.ml -width 10c -text "Used for events which occur at precise\
points over the given time scale. E.g., Phone rang at 2:00 pm."
$c create window 9c 3c -window $c.ml

$Sc addtag well withtag [$c create rect 1l.5¢c 6.5¢ 2.5c¢c 5.5c \
-outline black -fill ([lindex ($c config -bg] 4]]
$c addtag well withtag [rulerMkTabIL $c [winfo pixels $c 1.5c] \
[winfo pixels $c 6¢l]
$c create text 2c 7.15c -text "Limitless Event" \
-font $namef2 -fill maroon
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message $c.m2 -width 10c -text "Event that occured at some unknown)\
time in past and continues in future.E.q., It has been raining today."
$c create window 9c 6c -window Sc.m2

$c addtag well withtag [Sc create rect 1.5¢c 9.5¢ 2.5c 8.5c \
-outline black ~£fill [lindex [$c config -bg] 4]}

$c addtag well withtag [(rulerMkTabFE $c [winfo pixels S$c 1.5c] \
[winfo pixels $c 9.05c]]

$c create text 2c 10.15¢c -text "Fixed Event" \

-font Snamef2 -fill maroon

message $c.m3 -width 10c -text "Event that occured between two points\
on the given time scale. Activity has precise start and end points.\
E.g., We had lunch between 2 & 3 pm."

$c create window 9¢ 9c -window Sc.m3

$c addtag well withtag [$c create rect 1.5¢ 12.5¢c 2.5¢c 11.5c \
-outline black -fill [lindex [Sc config -bg] 4]]

$c addtag well withtag {rulerMkTabFL $c ([winfo pixels Sc 1.5c] \
{winfo pixels $c 12.05c}])

$c create text 2c 13.15c -text "FixedLeft Event"” \

~-font S$namef2 -fill maroon

message $c.md4 -width 10c -text "Event that starts at a known fixed\
point and continues in future. E.g., Basketball game started at 6 pm\
and went on till late evening”

$c create window 9c¢c 12c -window S$c.m4

$c addtag well withtag [$c create rect 1.5¢c 15.5c 2.5c¢c 14.5c \
-outline black ~fill [lindex [$c config -bg] 41]]

$c addtag well withtag [rulerMkTabFR $c [winfo pixels Sc 1.5c] \
{winfo pixels $c 15.05c]]

$c create text 2c 16.15c -text "FixedRight Event" \

-font Snamef2 -fill maroon

message S$c.m5 -width 10c -text "Event which started at some unknown\
poeint in past and has fixed end point. Complement of FixedLeft Event.\
E.g., After a long sleep, I woke up at 12:00 pm."

Sc create window 9c¢ 15¢ -window S$c.m5

$c addtag well withtag ($c create rect 1.5¢ 18.5¢ 2.5c 17.5¢ \
-outline black -fill (lindex [$c config -bg] 4]]

Sc addtag well withtag [rulerMkTabQues $c ([winfo pixels $c 1.5c] \
[winfo pixels $c 18.05c]}

$c create text 2c 19.15c -text "What's True" \

-font $namef2 -fill maroon

message S$c.m6é -width 10c -text "This symbol is used for querying the \
system. It tells, all what is true for a selected event"
$c create window 9c 18c -window Sc.m6

frame $u.frame -relief raised
pack Su.frame -side bottom -fill x -pady 2m
button $u.frame.b ~text " OK " -command {destroy Su}
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pack $Su.frame.b -side left -expand 1
pack $u.v_scroll -side right -fill y
pack $u.sym can -side left -expand 1
font delete txtftl txtft2 txtft3
#!/usr/local/bin/wish

ruler.tcl --

This script creates a canvas widget that displays a ruler
with tab stops that can be set, moved, and deleted.

A list of all global variables
user_filename is the name of the file entered by the user.
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set user_ filename event_ details.dat

# proc positionWindow to sets the position of the Window on the screen.

proc positionWindow w {
wm geometry $w +300+300
}

#Font variable
set font {Courier 12}

#Color for the widget items
set color #2230f£0

rulerMkTab --
This procedure creates a new circular polygon in a canvas to
represent a point event.

Argquments:
c - The canvas window.
X, v - Coordinates at which to create the tab stop.
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proc rulerMkTab {c x y} {
set vl [winfo fpixels S$c .3c]
$c create oval [expr $x-Sv1/2] [expr S$y-$vl1l/2] [expr $x+$Sv1/2] \
[expr Sy+$v1/2] -fill black

# rulerMkTabIL --

# This procedure creates a new Infinite line item in a canvas.
#

# Arguments:

$ c - The canvas window.

$ x, v - Coordinates at which to create the IL item.

#

# Arguments:
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proc rulerMkTabIL {c x y} |
set vl [winfo fpixels $Sc lc¢]
$c create line $x Sy [expr $x+$vl] Sy \
-arrow both -fill black -width 8

}

# rulerMkTabIL2 --
# This procedure creates a new Infinite line item in a canvas.
# Behaves similar to the above but covers the entire length.

proc rulerMkTabIL2 {c x y} {
global color
set vl (winfo fpixels S$Sc 1l2c]
$c create line $x Sy [expr $x+S$vl] $y -arrow both -fill Scolor \
-width 8
}

# Set no. of fixed objects as numFE

set numFE O

# rulerMkTabFE --

# This procedure creates a new Fixed End line item in a canvas.

#
# Arguments:

# c - The canvas window.
#x, vy - Coordinates at which to create the FE item.
#

proc rulerMkTabFE {c x y} {
set vl (winfo fpixels $c 1lc]
$c create line $x Sy [expr S$x+S$Svl] \
$y -fill black -width 8

——

# rulerMkTabFL

# This procedure creates a new Fixed Left item in a canvas.
#

# Arguments:

$ c - The canvas window.

$%x, vy - Coordinates at which to create the FE item.
#

proc rulerMkTabFL {c x y} |
set vl [winfo fpixels $c 1lc]
Sc create line $x Sy [expr $x+Svli] \
Sy -fill black -width 8 -arrow last

# rulerMkTabFL2
# This procedure creates a new Fixed left item in a canvas.
# Behaves similar to the above but covers the right length.

proc rulerMkTabFL2 {c x y} {
upvar #0 demo_rulerInfo v
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global color
set vl [winfo fpixels $c 1lc]
$c create line $x $y Sv(right) \
Sy -fill Scolor -width 8 -arrow last

# rulerMkTabFR

# This procedure creates a new Fixed Right item in a canvas.
#

# Argquments:

$# c - The canvas window.

# x, v - Coordinates at which to create the FE item.
#

vl plays an important role in positioning the item.

proc rulerMkTabFR {c x y} {
set vl [winfo fpixels $c lc]
$c create line $x Sy [expr $x+S$vl] Sy \
-fill black -width 8 —-arrow first
}

# rulerMkTabFR2
# This procedure creates a new Fixed Right item in a canvas.
# Behaves similar to the above but covers the left length.

proc rulerMkTabFR2 { ¢ x y} {
upvar #0 demo_rulerlInfo v
global color
set vl [winfo fpixels $c 1lc]
$c create line $v(left) Sy $x Sy -fill black -width 8 \
-fill S$color -width 8 -arrow first

}

# setting up the window manager options.
set w .ruler

glcbal tk_library

catch {destroy S$w}

toplevel $w

wm title $w "Entering Information"

wm iconname $w "ruler"

positionWindow S$w

set ¢ $w.c

# Creating the first section of the entering information screen.
frame $w.entry -borderwidth 1 -relief raised

label $w.entry.event name -text "Event Name:"

entry $w.entry.event_entry -width 25 -textvariable event

label $w.entry.fact_name -text "Event Description:”
entry $w.entry.fact_entry -width 25 -textvariable descrip

button $w.entry.color -text “Pick Color"™ \
-command { source colordlg.tcl }
button $w.entry.ok -text "OK" -command {
puts "Event Name: $event”
puts "Fact Description: $descrip”
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puts "Color selected for this fact: $color"
# Important file manipulation steps ...

if { Sevent == "" || Sdescrip == "" } {
set result [tk messageBox -parent .ruler \
-title Error -type ok -icon error \
-message \

"Missing Event Name or Event description !! "}
focus $w.entry.event_entry
} else {

file write event_details.temp S$Sevent $color S$descrip

}

# Using grid manager to place the objects.

grid config $w.entry.event name -column 0 -row 0 -sticky e
grid config $w.entry.event_entry -column 1 -row Q0 -sticky snew
grid config $w.entry.color -column 2 -row 0 -sticky snew

grid config $w.entry.fact name -column 0 -row 1 -sticky e
grid config $w.entry.fact_entry -column 1 -row 1 -sticky snew
grid config $w.entry.ok -column 2 -row 1 -sticky snew

pack $w.entry -side top -fill x -ipady lc -ipadx lc

frame $w.buttons
pack $w.buttons -side bottom -fill x -pady 2m
button $w.buttons.cancel -text " Cancel " -command { cancel Sw }
button $w.buttons.continue -text "Continue" \
-command {continue proc $w knowledge base S$color}

button Sw.buttons.done -text " Done " -command {
done $w knowledge base Scolor
}
button Sw.buttons.help -text " Help " -command { source
enterHelp.tcl}
pack $w.buttons.cancel S$w.buttons.continue $w.buttons.done \
Sw.buttons.help -side left -expand 1

focus $w.entry.event_entry

#File for storing event_details.
proc file _write { filename event color descrip } ({
return {catch {
set fileid (open Sfilename "a+"]
puts $fileid Sevent
puts $fileid $color
puts $fileid Sdescrip
puts "Data written to file $filename”
close $fileid
}]
}

#Cancel procedure, invoked when user clicks on the Cancel button.
proc cancel { w } {
puts "Procedure cancel called "
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upvar #0 point_Obj po
upvar #0 infinite_Obj ie
upvar #0 finitel Obj fl
upvar #0 finiter Obj fr
upvar #0 finite_Obj f
global count countIL countfL
global countFR countFE
global EventNameEntered
global user_filename
$w.entry.event_entry delete 0 end
$w.entry.fact_entry delete 0 end
set color #2230f0
$w.c delete boxl tab tabl tab2 tab3 tab4 active activel \
active2 active3 actived4 box fendl fixed

#Copy the Suser_filename event_details.temp

if {[file exists Suser_filename}} {

file copy ~force Suser filename event_details.temp
} else {

file delete event_details.temp

}

# Unsetting the arrays
1f ([array exists po]l} { unset po }
if {[array exists ie]} { unset ie }
if {[array exists fl]} { unset fl }
if {[array exists fr]} { unset fr }
if {[array exists f]} { unset f }

# Reinitializing the variables used arrays
set count -1

set countIL -1

set countFL -1
set countFR -1
set countFE -1

update
focus Sw.entry.event _entry

}

#Procedure invoked when user clicks on the "Continue" button.
proc continue proc {w filename color} f{

puts "Procedure continue called "

upvar #0 point_Obj po

upvar #0 infinite_Obj ie

upvar #0 finiter_ Obj fr

upvar #0 finitel Obj fl

upvar #0 finite_ Obj £

global event_details.temp
global user_filename nfname
global count countIL countFL
global countFR countFE
global numFE
set numFE $countFE
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$w.entry.event_entry delete 0 end

$w.entry.fact_entry delete 0 end
Sw.c delete boxl tab tabl tab2 tab3 tab4 active activel \

active2 active3 actived4 actived box fendl fixed
# Copy the file event_details.temp to Suser_ filename
file copy -force event_details.temp $user_filename
# Writing the details of the events to the file.
# Information related to point objects will be stored in

# point.dat and rest will be in integral.dat

set color {string trimleft "Scolor" "#"]
set color c$color

set fileid (open point.dat "a+"]
if {[array exists po]} {

foreach index [array names po] |{
set val S$po($index)

if {($val == -1 } {
continue
} else {

set val (expr int(Sval)*100]
set input "point($val,S$color,l)."
puts $fileid S$input
}
}
set input ""
puts $fileid $input
puts "Data written to file point.dat"
close $fileid

}

set fileid [open integral.dat "a+"]

if {{array exists ie]} {
foreach index [array names ie] ({
set val $ie($index)

if {$val == -1} {
continue
} else {

set val ([expr int($val)*100]

set input "integral(0,1200, Scolor,1200)."
puts $fileid $input

}

}

if ([array exists fr]} {
foreach index [array names fr] ({
set val $fr(Sindex)
if {(Sval == -1} ({
continue
} else {
set val [expr int ($val)*100]

139



APPENDIX B. SOURCE CODE

set input "integral(0,Sval, $color,Sval)."
puts S$fileid Sinput
}

}

if {[array exists £f1]} ({
foreach index [array names fl] ({
set val $fl($Sindex)
if {Sval == -1} {
continue
} else {
set val [expr int($val)*100]
set diff [expr 1200 - Svall
set input "integral ($val, 1200, Scolor,S$diff}."
puts S$fileid S$input
}

if ([array exists f]} {
for {set indexl 0} ($indexl<=S$ScountFE} {incr indexl} {
set vall $f(Sindexl1l, 1)
set vall ([expr int($vall)*100]

set val2 $f{$indexl, 2)

set val2 (expr int($val2)*100]
set diff [expr $val2-$vall]

if {$vall i= -1} {

set input "integral(S$vall,$val2,S$color,S$diff) .”
puts $input

puts $fileid Sinput

}

}

set input ""
puts $fileid $input

puts "Data written to file integral.dat"
close $fileid
set color #2230f0

# Unsetting the arrays

if {[array exists po]} { unset po }
if {[array exists ie]} { unset ie }
if {[array exists f1]} { unset fl }
if {(array exists fr]} { unset fr }
if {[array exists f]} ( unset £ }

# Reinitializing the variables used in various arrays
set count -1
set countIL -1
set countFL -1
set countFR -1
set countFE -1
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update
focus Sw.entry.event_entry
if {$nfname != ""} ({

file copy -force event_details.dat $nfname

}
}

#Procedure invoked when the user clicks on the "Done" button.
proc done {w filename color} {
puts "Procedure done called "
upvar #0 point_Obj po
upvar #0 infinite_Obj ie
upvar #0 finiter Obj fr
upvar #0 finitel Obj £l
upvar #0 finite Obj f

global event_details.temp

global user_filename nfname
global count countIL countFL

global countFR countFE
global numFE
set numFE S$countFE
# Copy the file event_details.temp to S$user filename
if {(file exists event_details.temp]} {

file copy -force event_details.temp Suser_ filename

}

# Writing the details to the file
# Information related to point objects will be stored in
# point.dat and rest will be in integral.dat

set color (string trimleft "Scolor" "#"]
set color c$color

set fileid [open point.dat "a+"]

if {[array exists pol} {
foreach index [array names po] |{
set val $po($index)
if (Sval == -1 } {
continue
} else {
set val [expr int(Sval)*100}
set input "point($val,Scolor,1l)."
puts $fileid $input
}
}
set input ""
puts $fileid $input
puts "Data written to file point.dat"”
close $fileid
}

set fileid [open integral.dat "a+"]

if {[array exists iel]} {
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foreach index (array names ie] {(
set val $ie($index)
if {$val == -1} {
continue
} else {
set val [expr int(S$val)*100]
set input "integral(0,1200,Scolor,1200)."
puts $fileid $input
}

}

if ([array exists fr}} {
foreach index [array names fr] {

set val $Sfr(Sindex)

if ($val == -1} {
continue

} else {

set val (expr int(Sval) *100)

set input "integral(0,$Sval, $color,$val)."

puts Sfileid $input

}

}

if {([array exists f1]} {
foreach index f{array names fl] ({
set val S$fl(Sindex)
if {$val == -1} ({
continue
} else {
set val [expr int(Sval)*100)
set diff [expr 1200 - $val)
set input "integral($val, 1200,$color,$diff)."
puts $fileid Sinput
}

}

if ([array exists f]} |
for {set indexl 0} {($indexl<=ScountFE} {incr indexl} ({

set vall S$f($indexl,1)
set vall [expr int($vall)*100]

set val2 Sf($Sindexl, 2)
set val2 [expr int(S$val2)*100]
set diff [expr $val2-$vall]
if ($vall '= -1} {
set input "integral(Svall,$val2,S$color,$diff)."
puts $Sinput
puts S$fileid $input
}

}

set input ""
puts $fileid $input
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puts "Data written to file integral.dat"”
close $fileid

set color #2230f0

# Unsetting the arrays

if {[array exists po]} { unset po }
if {[array exists ie]} ( unset ie }
if {[array exists fl]} ( unset fl }
if {[array exists fr]} ( unset fr }

if {{array exists f]} { unset f }

# Reinitializing the variables used in various arrays
set count -1

set countlIL -1

set countFL -1

set countFR -1

set countFE -1

if {S$Snfname '= ""} ({
file copy -force event_details.dat S$nfname

}

destroy $w
}

canvas $c -width 17c¢ -height 6c
pack $Sw.c -side top -fill x

# Create a font to show the text on the ruler.

font create txtft2 -family Courier -size 12 -slant italic \
-weight bold

set newf txtft2

#Info about the box

set demo_boxInfo(a) 0

set demo_boxInfo(motionProc) MoveNull
if ([winfo depth $c] > 1} {

set demo_boxInfo(boxStyle) "-fill {} -outline \

black -width 1"

set demo_boxInfo(active) "-fill red \

-outline black -width 1"

} else {

set demo_boxInfo(boxStyle) “-fill {} -outline \
black -width 1"
set demo_boxInfo(active) "-fill black \

-outline black -width 1"
}

#Info about the ruler

set demo_rulerInfo(grid) .25c
set demo_rulerinfo(left) ([winfo fpixels S$c lc]
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set demo_rulerInfo(right) [winfo fpixels $c 13c]
set demo_rulerInfo(top) [winfo fpixels $c 1lc}
set demo_rulerInfo(bottom) ([winfo fpixels $c 1.75c]
set demo_rulerInfo(size) ([winfo fpixels $c .4c]
set demo_rulerInfo(normalStyle) "-fill $color”
puts "color is $color”
if {[winfo depth $cl > 1} {
set demo_rulerInfo{activeStyle) "-fill red -stipple (}"
set demo_rulerInfo(deleteStyle) [list -fill red \
-stipple @[file join Stk library demos images gray25.bmp]]
} else {
set demo_rulerInfo(activeStyle) "-fill black -stipple {}"
set demo_rulerInfo(deleteStyle) ([list -fill black \
-stipple @[file join $tk_library demos images gray25.bmp]]

}

Sc create line 1lc 0.5c lc 1lc 1l3c 1lc 13c 0.5¢c -width 2
$c create text .5c .75c -text "AM" -font Snewf -anchor s -fill maroon
for {set i 0} (Si < 12} {incr i} {
set x [expr $i+l]
if ($i==0} {
Sc create line ${x}c lc ${x}c 0.6c -width 1
$c create line $x.25c lc $x.25c¢ 0.8c -width 1
$c create line $x.5c 1lc $x.5¢ 0.7c -width 1
$c create line $x.75¢c 1lc¢ $x.75c 0.8c -width 1
$c create text S$x.1l5c .75c -text "12" -font Snewf -anchor s \
-fill maroon
} else {
Sc create line $(x}lc lc ${x}c 0.6c -width 1
Sc create line $x.25c lc $x.25c 0.8c -width 1
Sc create line $x.5c lc $x.5c 0.7c -width 1
Sc create line $x.75c lc $x.75c 0.8c -width 1
$Sc create text $x.15c .75c -text $i -font S$newf -anchor s \
~-£fill maroon
}
}
# prints the last 12 on the scale
set x [expr $x+1]
Sc create text $x.l17c .75c -text $i -font S$newf —anchor s -fill maroon
Sc create text [expr S$Sx+l]c .75¢ -text "PM" -anchor s -font Snewf\
-fill maroon

# Tags below are for the circular object
$c addtag well withtag [$c create rect 2c 4.5c 3c 3.5c \
-outline black -fill [lindex [$c config -bg] 4]]
$c addtag well withtag [rulerMkTab $c [winfo pixels $c 2.5c] \
(winfo pixels $c 4c]]
$c create text 2.25c 5.25c -text "Point" -font $newf -£fill maroon
Sc create text 2.25c 5.75c -text "Event" -font $newf -fill maroon

# Tags below are for the Infinite Line object

$c addtag welll withtag [$c create rect 4.5¢c 4.5c 5.5¢ 3.5c \
-outline black -fill ([lindex [$c config -bgl 4]]

$c addtag welll withtag {rulerMkTabIlL $c [winfo pixels $c 4.5c] \
(winfo pixels $c 4.15c]]
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$c create text 4.75c 5.25¢c -text "Limitless" -font Snewf -fill maroon
$c create text 4.75¢c 5.75c -text "Event”™ -font Snewf -fill maroon

# Tags below are for the Fixed End object
Sc addtag well2 withtag [$c create rect 7c¢ 4.5c 8c 3.5¢c \
~outline black -fill ([lindex ([$Sc config ~bg] 4]]
$c addtag well2 withtag [rulerMkTabFE $c (winfo pixels $c 7.02c] \
{winfo pixels Sc 4.15c]]
$c create text 7.5¢ 5.25c -text "Fixed" -font Snewf -fill maroon
$c create text 7.5c 5.75c -text "Event” ~font Snewf -fill maroon

# Tags below are for the Fixed left object

Sc addtag well3 withtag [$c create rect 9.5¢c 4.5¢c 10.5¢c 3.5c \
-outline black ~fill [lindex [$c config -bg] 4]]

Sc addtag well3 withtag (rulerMkTabFL $c [winfo pixels $c¢ 9.52c] \
[winfo pixels Sc 4.15c]]

Sc create text 10c 5.25¢ ~text "FixedLeft"™ -fill maroon -font Snewf

Sc create text 10c 5.75¢ -text "Event" -fill maroon -font Snewf

# Tags below are for the Fixed right object
$c addtag welld4 withtag [$c create rect 12c 4.5c 13c 3.5c \
-outline black -fill [lindex [$c config -bg] 4]]
$c addtag welld4 withtag [rulerMkTabFR $c [winfo pixels Sc 12.02c] \
(winfo pixels $c 4.15c}]]
Sc create text 13c 5.25¢c -text "FixedRight" -fill maroon -font S$newf
$c create text 12.5¢c 5.75¢c ~text "Event" -fill maroon -font Snewf

#Bindings below are for the Infinite Line object

$c bind welll <1> "rulerNewTabIL $c $%$x 3%y"

$c bind tabl <1> "rulerSelectTablIL $c %x %y”"

$c bind welll <Bl-Motion> "rulerMoveTabIL $c %x %sy"

$c bind welll <Any-ButtonRelease-1> "rulerReleaseTabIL Sc"

#Bindings below are for the Point object

$c bind well <1> "rulerNewTab Sc %x $y"

$c bind tab <1> "rulerSelectTab $c %x %y"

$c bind well <Bl-Motion> "rulerMoveTab Sc %x %y"

$c bind well <Any-ButtonRelease-1> "rulerReleaseTab S$c"

#Bindings below are for the Fixed End object

$c bind well2 <1> "rulerNewTabFE $c %x sy"

Sc bind tab2 <1> "rulerSelectTabFE $c %x %y"

$c bind well2 <Bl-Motion> "rulerMoveTabFE Sc $x $y"

$c bind well2 <Any-ButtonRelease-1> "rulerReleaseTabFE $c"

#Bindings below are for the Fixed Left object

$c bind well3 <1> "rulerNewTabFL $c %x $%y"

$c bind tab3 <1> "rulerSelectTabFL $c %x $y"

$c bind well3 <Bl-Motion> "rulerMoveTabFL $c %x %$y"

$c bind well3 <Any-ButtonRelease-1> "rulerReleaseTabFL S$c”

#Bindings below are for the Fixed Right object
$c bind well4 <1> "rulerNewTabFR $c %x 3%y"
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$c bind tab4 <1> "rulerSelectTabFR $c %x %y"
$c bind well4 <Bl-Motion> "rulerMoveTabFR $c %x %y"
$c bind well4 <Any-ButtonRelease-1> "rulerReleaseTabFR $c”"

font delete txtft2
source Bruler.tcl
#!/usr/local/bin/wish

#Procedures controlling the behaviour of various objects
e OBJECT POINT ———-——=———mmem e
Position gives the position of the point objects on the ruler;
count helps in keeping a count of the number of point objects

test is a boolean variable, to check if a new object is
created or not, initially set to false (0)

LI ]

set Position -1
set count -1

set test O

# rulerNewTab --

# Does all the work of creating a tab stop, including creating the
# point object and adding tags to it to give it tab behavior.

#

# Arqguments:

# c - The canvas window.

# x, vy - The coordinates of the tab stop.

proc rulerNewTab {c x y} {
global count
global test
incr count
set test 1

upvar #0 demo_rulerlInfo v

$c addtag active withtag (rulerMkTab $c $x Syl
$c addtag tab withtag active

set v(x) S$x

set v(y) Sy

rulerMoveTab S$c $x Sy

# rulerSelectTab --

# This procedure is invoked when mouse button 1 is pressed over

# a tab. It remembers information about the tab so that it can

# be dragged interactively.

#

# Arguments:

# c - The canvas widget.

# x, v - The coordinates of the mouse (identifies the point by
# which the tab was picked up for dragging).

proc rulerSelectTab {c x y} {
global test
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global Position
set test O

upvar #0 demo_rulerInfo v

set v(x) [$c canvasx $x Sv(grid)]

set v(y) [expr $v{top)+2]

$c addtag selected closest Sv(x) Sv(y)
set unit 35.457

set tmp [expr int(((Sv(x)/Sunit)-1)*100}]
set Position {[expr $tmp/100.00]

$c addtag active withtag current

eval "$Sc itemconf active $v(activeStyle)"

$c raise active

$c bind tab <Bl-Motion> "rulerMoveTab $c %x %y"

$c bind tab <Any-ButtonRelease-1> "rulerReleaseTab $c"

—

# rulerMoveTab --

# This procedure is invoked during mcuse motion events to drag a tab.
# It adjusts the position of the tab, and changes its appearance if
# it is about to be dragged out of the ruler.

#

# Argquments:

#$ c - The canvas widget.

¥ x, vy - The coordinates of the mouse.

proc rulerMoveTab {¢ x vy} {
upvar #0 demo_ruleriInfo v
if {(S$c find withtag active] == ""} ({
return
}
set cx ($c canvasx $x $v(grid)]
set cy ($c canvasy Syl
1f {Scx < Sv(left)} {
set cx $v{left)
}
if {$cx > Sv(right)} {
set cx Sv(right)
}
if {(Scy >= Sv(top)) && (Scy <= S$v(bottom))} {
set cy [expr $v(top)+2]
eval "$c itemconf active $v{activeStyle)"
} else {
set cy [expr Scy-$v(size) -2}
eval "$c itemconf active Sv{deleteStyle)"
}
$c move active [expr $cx-$v(x)] [expr Scy-$v(y)]
set v{x) S$cx
set v(y) Scy

# rulerReleaseTab --
# This procedure is invoked during button release events that end

# a tab drag operation. It deselects the tab and deletes the tab if
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# it was dragged out of the ruler.

#

# Arguments:

# c ~ The canvas widget.

# x, v - The coordinates of the mouse.

proc rulerReleaseTab c (
upvar #0 demo_rulerInfo v
upvar #0 point_Cbj p

glcbal count
global test
global Position
global color

if {[$c find withtag active] == {}} {
return
}
if {$v(y) != (expr Sv(top)+2]} {
Sc delete active
if {($test != "1"} {
foreach index (array names p] {
if {$p($index) == SPosition} {
set vall $index
}

set p(Svall) -1
incr count -1
}
} else {
eval "$c itemconf active -fill Scolor"

# xvalue will be shown only if the event is on
# the ruler line and not otherwise.

set unit 35.457
set tmp [expr int(((Sv(x)/Sunit)-1)*100)]
set xvalue [expr S$Stmp/100.00]}
if {Stest == "1"} [(
set p{$count) Sxvalue

} elseif { Stest == "Q"} (
foreach index [array names p] {
if {$p($index) == $Position} {

set val Sindex
}

}
set p($val) $xvalue

}
$c dtag active

set countIlL -1
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# rulerNewTabIL --

# Does all the work of creating a tab stop, including creating the

# Infinite line object and adding tags to it to give it a tab behavior.
#

# Arguments:

# c - The canvas window.

# x, vy - The coordinates of the tab stop.

proc rulerNewTabIL {c x y} {
global countIL
incr countIL
upvar #0 demo_rulerlInfo v
$c addtag activel withtag [rulerMkTabIL $Sc $x Sy]
$c addtag tabl withtag activel
set v(x) $x
set v(y) Sy
rulerMoveTablIL $c S$x Sy

rulerSelectTabIL --

This procedure is invoked when mouse button 1 is pressed over
a tab. It remembers information about the tab so that it can
be dragged interactively.

Arguments:

c - The canvas widget.

X, y - The coordinates of the mouse (identifies the point by
which the tab was picked up for dragging).
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proc rulerSelectTabIL (c x y} |
upvar #0 demo_rulerInfo v
set v(x) ([$c canvasx $x Sv(grid)]
set v(y) [(expr Sv(top)+2]
$c addtag activel withtag current
eval "$Sc itemconf activel $v(activeStyle)"
$c raise activel
$c bind tabl <Bl-Motion> "rulerMoveTabIL S$Sc %x %y"
$c bind tabl <Any-ButtonRelease-1> "rulerReleaseTabIL Sc*

# rulerMoveTabIL --

# This procedure is invoked during mouse motion events to drag the IL.
# It adjusts the position of the IL, and changes its appearance if

# it is about to be dragged out of the ruler.

#

# Arguments:

# c - The canvas widget.

# x, ¥y - The coordinates of the mouse.

proc rulerMoveTabIL {c x y} {
upvar #0 demo_rulerlInfo v
if {[$c find withtag activel] == ""} {
return
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}
set cx [$c canvasx $x $v(grid)]
set cy [$c canvasy $y]
if {$Scx < Sv{left)} {
set cx $Sv(left)
}
if {Scx > Sv(right)} {
set cx $v(right)
}
if ((Scy >= S$v(top)) && (Scy <= $v(bottom)}} {
set cy [(expr $v(top)+2]
eval "$c itemconf activel $v(activeStyle)"
} else {
set cy [expr S$Scy-$Sv(size)-2]
eval "S$c itemconf activel $v(deleteStyle)"
}
$c move activel [expr $cx-S$v(x)] (expr Scy-Sv(y}]
set v{x) Scx
set v(y) Scy

# rulerReleaseTabIL --

# This procedure is invoked during button release events that end
# a IL drag operation. It deselects the IL and deletes the IL if
# it was dragged out of the ruler.

#

# Arguments:

# c - The canvas widget.

# x, y - The coordinates of the mouse.

proc rulerReleaseTabIL c (
upvar #0 demo_rulerInfo v
upvar #0 infinite_Obj ie
global countIL
if {[$c find withtag activel] == {}} {
return
}
if ($v(y) != [expr Sv(top)+2]} {
$c delete activel
incr countIl -1
} else {
Sc delete activel
$c addtag tabl withtag [rulerMkTabIL2 Sc \
[winfo pixels $c lc] (winfo pixels $c lc]]

set unit 35.457
set tmp [expr int((($v(left)/Sunit)-1)*100)1]
set left [expr $tmp/100.00]

set tmp [expr int(((S$v(right)/$Sunit)-1)*100)]
set right [expr $tmp/100.00]

set ie($countlIl) 1

$c bind tabl <1> "rulerSelectTabIL2 $c %x %y"
$c dtag activel
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}

proc rulerSelectTabIL2 {c x y} {
upvar #0 demo_rulerInfo v
Sc addtag activel withtag current
eval "$c itemconf activel $v(activeStyle)"
$c raise activel
$c bind tabl <Bl-Motion> "rulerMoveTabIL $c %x $y"
$c bind tabl <Any-ButtonRelease-1> "rulerReleaseTabIL2 Sc"

proc rulerReleaseTabIL2 c {
upvar #0 demo_ruleriInfo v
upvar #0 infinite Obj ie
global countIL

if {[($c find withtag activel] == {(}} {
return

}

if {$v(y) !'= [expr S$v(top}+2]} {

Sc delete activel
set ie(ScountIl) -1
incr countiIL -1
} else {
eval "S$c itemconf activel $v{normalStyle)"
$c dtag activel

# Setting up a counter
set countFE -1

# rulerNewTabFE --

# Does all the work of creating a tab stop, including creating the
# Finite End object and adding tags to it to give it a tab behavior.
#

# Arguments:

$ c - The canvas window.

B x, vy - The coordinates of the tab stop.

proc rulerNewTabFE {c x y} {
upvar #0 demo_rulerInfo v
upvar #0 demo boxInfo w
global countFE
incr countFE
Sc dtag active2
$c dtag tab2
Sc dtag boxl
set w(a) O
$c addtag active2 withtag [rulerMkTabFE $c Sx Syl
$c addtag tab2 withtag active2
set v(x) $x
set v(y) Sy
rulerMoveTabFE $c $x Sy

151



APPENDIX B. SOURCE CODE

rulerSelectTabFE --

This procedure is invoked when mouse button 1 is pressed over
a tab. It remembers information about the tab so that it can
be dragged interactively.

Arguments:

c - The canvas widget.

X, ¥ - The coordinates of the mouse (identifies the point by
which the tab was picked up for dragging).
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proc rulerSelectTabFE (c x y} {
upvar #0 demo_rulerInfo v
set v(x) [$c canvasx $x Sv(grid)]}
set v(y) [expr $v(top)+2]

$c addtag selectedFE closest $v(x) S$v(y)
set unit 35.457

set tmp [expr int({($v(x)/Sunit)-1)*100)]
set PositionFE [expr $tmp/100.00]

set tags [$c gettags current]

$c addtag active2 withtag current

$c addtag tab2 withtag active2

eval "$c itemconf active2 Sv(activeStyle)"

Sc raise active2

$c bind tab2 <Bl-Motion> "rulerMoveTabFE $c %x %y"

$c bind tab2 <Any-ButtonRelease-1> "rulerReleaseTabFE S$c"

# rulerMoveTabFE --

# This procedure is invoked during mouse motion events to drag the FE.
# It adjusts the position of the FE, and changes its appearance if

# it is about to be dragged out of the ruler.

#

# Arguments:

# c - The canvas widget.

# x, y - The coordinates of the mouse.

proc rulerMoveTabFE {c x y} {

upvar #0 demo_rulerlInfo v

if {[$c find withtag active2] == ""} {
return

}

set cx [$c canvasx $x $Sv(grid)]

set cy [$c canvasy Syl

if {Scx < Sv(left)} {
set cx $v(left)

}

if {Scx > Sv(right)} {
set cx S$v(right)

}

if {(Scy >= Sv(top)) && (Scy <= Sv(bottom))} {
set cy ([expr S$v(top)+2]
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eval "S$c itemconf active2 $v(activeStyle)"”
} else {
set cy [expr Scy-$v(size)-2]
eval "$c itemconf active2 S$v(deleteStyle)"
}
$c move active2 ([expr $cx~-$v(x)] [expr Scy-Sv(y}]
set v(x) Scx
set v(y) Scy

# rulerReleaseTabFE --

# This procedure is invoked during button release events that end
# a FE drag operation. It deselects the FE and deletes the FE if
# it was dragged out of the ruler.

#

# Arguments:

$# c - The canvas widget.

# x, vy - The coordinates of the mouse.

proc rulerReleaseTabFE ¢ {
upvar #0 demo_rulerInfo v
upvar #0 finite_Obj f
global countFE
if {[$Sc find withtag active2] == {}} {
return
}
if {$v(y) !'= [expr Sv(top)+2]} {
Sc delete active2 tab2 boxl
set f($countfFE,1) -1
set f(ScountFE,2) -1
incr countfE -1
} else {
eval "Sc itemconf active2 Sv(normalStyle)"”
source box.tcl
Sc bind tab2 <1> "rulerSelectTabFE2 $c %x %y"

proc rulerSelectTabFE2 {c x y} {
upvar #0 demo_rulerInfo v
#Capturing the object closest to mouse cursor
set vx [Sc canvasx $x $Sv(grid)]
set vy [expr $Sv(top)+2]
Sc addtag fendl closest $Svx Svy
set unit 35.457
set tmp [expr int ((($vx/Sunit)-1)*100)]
set positionFE [expr $tmp/100.00}
set tags ([$c gettags current]

$c addtag active2 withtag current

$c addtag tab2 withtag active2

eval "Sc itemconf active2 $v(activeStyle)"

$c raise active2

$c bind tab2 <Bl-Motion> "rulerMoveTabFE Sc %$x %y"
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$c bind tab2 <Any-ButtonRelease-1> "rulerReleaseTabFE Sc"

source Cruler.tcl
#!/usr/local/bin/wish

# CountFL is used to keep a count of the # of objects created
# for Fixed Left event
set countFL -1

# rulerNewTabFL

# Does all the work of creating a tab stop, including creating the

# Fixed Left object and adding tags to it to give it a tab behavior.
¢

# Arguments:

# c - The canvas window.

# x, v - The coordinates of the tab stop.

proc rulerNewTabFL {c x y} (
upvar #0 demo_rulerInfo v
global countFL
incr countFL
$c addtag active3 withtag [rulerMkTabFL $c $x Syl
$c addtag tab3 withtag active3
set v(x) S$x
set v(y) Sy
rulerMoveTabFL $c $x Sy

——

rulerSelectTabFL --

This procedure is invoked when mouse button 1 is pressed over
a tab. It remembers information about the tab so that it can
be dragged interactively.

Arguments:

c - The canvas widget.

X, ¥y - The coordinates of the mouse (identifies the point by
which the tab was picked up for dragging).
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proc rulerSelectTabFL {c x y} {
upvar #0 demo_rulerInfo v
set v(x) [$c canvasx $x S$v(grid)]
set v(y) [expr Sv(top)+2]
$c addtag active3 withtag current
eval "$c itemconf active3 $v(activeStyle)"
$Sc raise active3
$c bind tab3 <Bl-Motion> "rulerMoveTabFL Sc %$x %y"
$c bind tab3 <Any-ButtonRelease-1> "rulerReleaseTabFL S$c"

154



APPENDIX B. SOURCE CODE

o9k 3= 3= Sk Sk 3E 3

rulerMoveTabFL --

This procedure is invoked during mouse motion events to drag the FL.

It adjusts the position of the FL, and changes its appearance if
it is about to be dragged out of the ruler.

Arguments:
c - The canvas widget.
X, ¥y - The coordinates of the mouse.

proc rulerMoveTabFL {c x y} {

I I IR I I IR R

upvar #0 demo_rulerInfo v
if {($c find withtag active3d] == ""} (
return
}
set cx [$c canvasx $x Sv(grid)]
set cy [Sc canvasy S$y]
if {Scx < S$v(left)} |
set cx $v(left)
}
if {$cx > $v(right)} {
set cx $Sv(right)
}
if {(Scy >= $v(top)) && (Scy <= $v(bottom))]} {
set cy ([expr $v(top)+2]
eval "$c itemconf active3d $v{activeStyle)"
} else {
set cy [expr Scy-$Sv(size)-2]
eval "$Sc itemconf active3d $v(deleteStyle)"
}
$c move activeld [expr S$cx-$v(x)] [expr S$cy=-Sv(y)]
set v(x) Scx
set v(y) Scy

rulerReleaseTabFL --

This procedure is invoked during button release events that end
a FL drag operation. It deselects the FL and deletes the FL if
it was dragged out of the ruler.

Arguments:
c - The canvas widget.
X, ¥y - The coordinates of the mouse.

proc rulerReleaseTabFL c {

upvar #0 demo_ruleriInfo v
upvar #0 finitel Obj fl
global countFL

if {[Sc find withtag active3] == (}} {
return

}

if {Sv(y) != [expr $Sv{top)+2]} |

$c delete active3
incr countFL -1

} else {
set unit 35.457
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set tmp [expr int(((Sv(x)/S$Sunit)-1)*100)]
set xvalue [expr $tmp/100.00]
set fl($countFL) S$xvalue

Sc delete active3

$c addtag tab3 withtag [rulerMkTabFL2 Sc \

$v(x) [winfo pixels Sc lc]]

$c bind tab3 <1> "rulerSelectTabFL2 Sc %x %y"
$c dtag active3

}

proc rulerSelectTabFL2 {c x y} {
upvar #0 demo_rulerInfo v
puts "Invoked from proc rulerSelectTabFL2"
global position
set v{x) [$c canvasx $x $v(grid)]
set v(y) [expr $v(top)+2]

$c addtag selected closest $v(x) Sv(y)

set unit 35.457
set tmp [expr int ((($v(x)/Sunit)-1)*100)]
set position [expr $tmp/100.00]}

$c addtag active3 withtag current

eval "$c itemconf active3 $v({activeStyle)"

$c raise active3

$c bind tab3 <Bl-Motion> "rulerMoveTabFL Sc %x %y"

$c bind tab3 <Any-ButtonRelease-1> "rulerReleaseTabFL2 Sc"
set unit 35.457

set tmp [expr int (((S$v(x)/Sunit)-1)*100)]

set xvalue [expr $tmp/100.00]

proc rulerReleaseTabFL2 ¢ ({
upvar #0 demo_rulerInfo v
upvar #C finitel Obj fl
global countFL
global position
if {[$c find withtag active3] == {}} {
return
}
if {$v(y) != [expr Sv(top)+2]} {
$Sc delete active3
foreach index [array names fl] ¢{
if { $fl($index) == $position} {
set vall $Sindex
}
}
set f1l($vall) -1
incr countfL -1

} else {
set unit 35.457
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#
#

set tmp [expr int({({Sv(x)/Sunit)-1)*100)]
set xvalue [expr S$tmp/100.00]
foreach index {array names fl] {
if { $fl1(Sindex) == $position} (
set val $index
}

}
set fl(Sval) Sxvalue

$c delete active3
$c addtag tab3 withtag [rulerMkTabFL2 Sc \
$v(x) [winfo pixels Sc 1lc]]
$c bind tab3 <1> "rulerSelectTabFL2 S$c %x %y"
$c dtag active3

-------------------- OBJECT-FR ~—————————====mmmmmmmmeemme o

countFR is used to keep a count of the # of objects created
for Fixed Right event

set countFR -1

FE ek e AR

rulerNewTabFR =--

Does all the work of creating a tab stop, including creating the
Fixed Right object and adding tags to it to give it a tab behavior.
Arguments:

c - The canvas window.

X, ¥y - The coordinates of the tab stop.

proc rulerNewTabFR {c x y} {

B A= I I A = I A

upvar #0 demo_rulerInfo v

global countFR

incr countfR

$c addtag actived4 withtag [rulerMkTabFR Sc $x Syl
S$Sc addtag tab4 withtag actived

set v(x) $x

set v(y) Sy

rulerMoveTabFR $c $x Sy

rulerSelectTabFR

This procedure is invoked when mouse button 1 is pressed over
a tab. It remembers information about the tab so that it can
be dragged interactively.

Arguments:

c - The canvas widget.

X, y - The coordinates of the mouse (identifies the point by
which the tab was picked up for dragging).

proc rulerSelectTabFR {(c x y} {
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upvar #0 demo_rulerInfo v

set v(x) [$c canvasx $x Sv(grid)]

set v(y) [expr $Sv(top)+2]

Sc addtag active4 withtag current

eval "$c itemconf active4 S$v(activeStyle)"”

$c raise actived

$c bind tabd4 <Bl-Motion> "rulerMoveTabFR $c %x $y"

$c bind tab4 <Any-ButtonRelease-1> "rulerReleaseTabFR S$c"

—

# rulerMoveTabFR

# This procedure is invoked during mouse motion events to drag the FL.
# It adjusts the position of the FR, and changes its appearance if

# it is about to be dragged out of the ruler.

#

# Arguments:

# c - The canvas widget.

#x, v - The coordinates of the mouse.

proc rulerMoveTabFR (c x y} |
upvar #0 demo_rulerlInfo v
if {[Sc find withtag actived] == ""} {
return
}
set cx [$c canvasx $x $v(grid)]
set cy [Sc canvasy Syl
if {Scx < Sv(left)} {
set cx Sv({left)
}
if {Scx > Sv{right)} {
set cx $v(right)
}
if {(Scy >= Sv(top)) && ({Scy <= Sv{bottom))} {
set cy [expr $v(top}+2]
eval "$c itemconf activeq4 Sv(activeStyle)"
} else {
set cy [expr Scy-$v(size)-2)
eval "Sc itemconf active4 $v(deleteStyle)"
}
Sc move active4 [expr $cx-S$v(x})] [expr Scy-$v(y)]
set v(x} Scx
set v{y) S$Scy

# rulerReleaseTabFR

# This procedure is invoked during button release events that end
# a FR drag operation. It deselects the FR and deletes the FR if
# it was dragged out of the ruler.

#

# Arguments:

# c - The canvas widget.

#x, y- The coordinates of the mouse.

proc rulerReleaseTabFR c¢ {
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upvar #0 demo_rulerInfo v
#
#Value nv adds [winfo fpixels Sc lc] to v(x)
#

set nv [expr $v(x)+35.457]

upvar #0 finiter Obj fr

global countFR

if {{$c find withtag actived] == ({}} {
return

}

if {Sv(y) !'= [expr Sv(top)+2]} {

Sc delete actived
incr countFR -1
} else {
set unit 35.457
set tmp [expr int(($v(x)/Sunit)*100)]
set xvalue [expr $tmp/100.00]
set fr(ScountFR) S$xvalue

$c delete actived

$c addtag tab4 withtag [rulerMkTabFR2 Sc \
$nv [winfo pixels $c lc]]

$c bind tab4 <1> "rulerSelectTabFR2 $c %x %y"
$c dtag actived

}

proc rulerSelectTabFR2 (¢ x y} {
upvar #0 demo_ruleriInfo v
global positionFR
set v(x) [$c canvasx $x Sv(grid)]
set v(y) [expr Sv(top)+2]

$c addtaqg selected closest Sv(x) Sv(y)

set unit 35.457

set tmp {expr int((Sv(x)/$unit)*100)]
set positionFR [expr $tmp/100.00]

set positionFR [expr $positionFR - 1]

$c addtag actived4 withtag current

eval "Sc itemconf actived4 Sv(activeStyle}"

$c raise actived

$c bind tab4 <Bl-Motion> "rulerMoveTabFR $Sc %x %y"

$c bind tab4 <Any-ButtonRelease-1> "rulerReleaseTabFR2 Sc"

proc¢ rulerReleaseTabFR2 c {
upvar #0 demo_rulerInfo v
upvar #0 finiter Obj fr
global countFR
global positionFR

if {[$c find withtag actived4] == (}} {
return

}

if (Sv(y) !'= [expr $v(top)+2]} |
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$c delete actived
foreach index [array names fr] (
if { $fr(Sindex) == $positionFR} |
set vall $index
}

}

set fr(Svall) -1

incr countfR -1

} else {
set unit 35.457
set tmp {expr int ({$v(x)/Sunit)*100)]
set xvalue [expr $tmp/100.00]
set xvalue [expr $xvalue - 1]
foreach index [array names fr] {
if { $fr(Sindex) == SpositionFR} |
set val $index
}
}
set fr(Sval) S$xvalue

Sc delete actived

Sc addtag tab4 withtag [rulerMkTabFR2 $c \
Sv(x) {winfo pixels Sc 1lc]]
Sc bind tab4 <1> "rulerSelectTabFR2 $c %x %y"
Sc dtag actived

#!/usr/local/bin/wish

# This file creates the query screen and its underlying functionality.

# proc positionWindow to sets the position of the Window on the screen.

proc positionWindow w {
wm geometry Sw +300+300
}

#Font variable
set font {Helvetica 14}

#Default color for the widget items

set color #2230f0

#begin

# rulerMkTab --

# This procedure creates a new circular pelygon in a canvas to

# represent a point event.
#
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# Arguments:

# c - The canvas window.

# x, y - Coordinates at which to create the tab stop.
#

# Arguments:

# w - The name of the window to position.

proc rulerMkTab {c x y} {
global color
puts "Color for point cbject is Scolor"”
set vl [winfo fpixels Sc .3c¢]
$c create oval [expr $x-Sv1/2] [expr $y-$v1/2] [expr S$x+Svl/2] \
[expr $y+$v1/2] -£fill black

# rulerMkTabIL -~

# This procedure creates a new Infinite line item in a canvas.
#

# Arguments:

# c - The canvas window.

# x, vy - Coordinates at which to create the IL item.

#

# Arguments:

$# w - The name of the window to position.

proc rulerMkTabIL {c x y} {
set vl (winfo fpixels $c 1lc]
$c create line $x $y [expr $x+Svl] Sy \
-arrow both -fill black -width 8

}

# rulerMkTabIL2 --
# This procedure creates a new Infinite line item in a canvas.
# Behaves similar to the above but covers the entire length.

proc rulerMkTabIL2 {c x y} {
global color
set vl [winfo fpixels Sc 1l2c]
Sc create line $x $y [expr $x+$vl] Sy -arrow both -fill $color \

~width 8
}
# rulerMkTabFE --
# This procedure creates a new Fixed End line item in a canvas.
#
# Arguments:
# c - The canvas window.
# x, vy - Coordinates at which to create the FE item.
#
# Arguments:
#w - The name of the window to position.
# Here vl plays a role in positicning the item especially w.r.t y axis.

proc rulerMkTabFE (c x y} (
set vl [winfo fpixels Sc 1lc]
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$c create line $x Sy [expr $x+$vl] Sy -fill black -width 8

—

rulerMkTabFL

This procedure creates a new Fixed Left item in a canvas.
Arguments:

c - The canvas window.

X, Yy - Coordinates at which to create the FE item.

Arguments:
w - The name of the window to position.
vl plays a role in positioning the item w.r.t y axis.

R e E N

proc rulerMkTabFL {c x y} {
set vl [winfo fpixels $c¢ 1c]
$c create line $x Sy [expr $x+S$Svl] \
$y —-fill black -width 8 -arrow last

# rulerMkTabFL2
# This procedure creates a new Fixed left item in a canvas.
# Behaves similar to the above but covers the right length.

proc rulerMkTabFL2 {c x y} {
upvar #0 demo_rulerInfo v
global color
set vl [winfo fpixels S$Sc 1lc]
Sc create line $x Sy S$v(right) \
Sy -fill S$Scolor -width 8 -arrow last

# rulerMkTabFR

# This procedure creates a new Fixed Right item in a canvas.
#

# Arguments:

# c - The canvas window.

#x, vy - Cocordinates at which to create the FE item.
#

# Arguments:

$# w - The name of the window to position.

#

vl plays an important role in positioning the item.

proc rulerMkTabFR {c x y} {
set vl [winfo fpixels S$c 1lc]
$c create line $x Sy [expr S$x+Svl] Sy \
-fill black -width 8 -arrow first
}

# rulerMkTabFR2

# This procedure creates a new Fixed Right item in a canvas.
# Behaves similar to the above but covers the left length.
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$ Sets up the window manager options.
set W .Juery_ ruler

global w

global tk_library

catch {destroy $w}

toplevel S$w

wm title $w "Querying the System"”

wm iconname S$w "QueryRuler”
positionWindow $w

set ¢ $w.c

¢ Frame-1l.

# Create a droplist for the events...

2
N

\

# drop_test_var is the global variable holding the value of

# the current selected event
global drop_test_var

proc DropListCreate (

basename text width height variable initial_value } {

upvar #0 Svariable var
set var "$initial_ value"

# Name of top-level widget to create.
set top Sbasename.top

#

# Widgets to enter data.
#

frame $basename ~bd 0

label $basename.lbl -text Stext -anchor e

entry $basename.ent -width S$Swidth
$basename.ent insert 0 "$initial_value"

DropButton S$basename.drop $basename.top $basename.ent

bind $Sbasename.ent <Return> \

"DropListSetVal $basename.ent $variable"
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bind $basename.ent <Key—-Escape> "wm withdraw Stop”

pack $basename.lbl -side left -ipady 3 -pady 7
pack $bhasename.ent -side left -expand 1 -ipady 3 -pady 7
pack Sbasename.drop -side left -ipady 3 -pady 7

#

# Drop-list is a top-level temporary window.
#

toplevel S$top -cursor top_left _arrow

wm overrideredirect $top 1

wm withdraw $top

# Create list
set frm Stop.frame
frame $frm -bd 4 -relief sunken

listbox $frm.list -height Sheight -width Swidth \
-selectmode single \
-yscrollcommand "$frm.scrollbar set"

bind $frm.list <Key-Escape> "wm withdraw Stop"

# Create scrollbar
scrollbar $frm.scrollbar \
-command "$frm.list yview"

pack $frm.scrollbar -side right -fill y
pack Sfrm.list -side left
pack $frm -side top

bind $frm.list <ButtonRelease-1> \
"DropListClick $top $basename.ent Svariable"

pack $basename

#
# Return list widget so you can fill it.
#
return $frm.list
}

# Returns selected item for a single-select list.
proc list_selected { listname } {
set indx [$listname curselection]

if { $indx != "" } {
set item ($listname get $indx]

return $item
} else {
return "";

}
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# Places value in global variable.
proc DropListSetVal { entry wvariable } {
upvar #0 $variable var

set value [$entry get]
if { Svalue !'= "" } {
set var $value
}
}

# Handles click on drop list widget.
proc DropListClick { basename entry variable } ({

catch {
set selected [list_selected $basename.frame.list]

if { $selected != "" } {
#
# Put item into entry widget.
#

Sentry delete 0 end
$entry insert 0 "Sselected"”

DropListSetVal Sentry $variable

}

wm withdraw $basename

# Makes drop list visible. Create with DropListCreate.
proc ShowDropList { basename associated widget } |

set x [winfo rootx $associated_widget]

set y [winfo rooty $associated_widget]

set y [expr Sy + [winfo height Sassociated _widget]]

wm geometry Sbasename "+S$Sx+Sy"

wm deiconify $basename
raise $basename

focus S$basename.frame.list

# Creates a button with a drop-down bitmap.
proc DropButton { name toplevel entry } {

button $name -image dnarrow \
-command "ShowDropList $toplevel $Sentry”
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return $name

}
#

# Bitmap data for down arrow bitmap.

#

set dnarrow data

[1]

#define dnarrow2 width 18

#define dnarrow2_height 18

static unsigned char dnarrow2 bits[] =

0x00, 0x00,

0x00,

Ox£f8, Ox7f,
0x00,

Oxc0O, OxO0f,
0x00,

0x00, 0x03,
0x00,

Oxfc, Oxff,

L

0x00,
0x00,
0x00,
0x00,

0x00,

0x00,
0x£0,
0xcO,
0x00,

0x00,

0x00,
0x3f,
0x0f,
0x00,

0x00,

0x00,
0x00,
0x00,
0x00,

0x00};

{
Oxfc,

0xfo,
0x80,

0x00,

Oxff,
0x3f,
0x07,

0x00,

image create bitmap dnarrow -data $dnarrow_data

set drop_test_var "Unset"™

global drop test_var

proc test value { }
global drop_test_var

global list_of colors
global list_of_events
global color

0x00,
0x00,
OXOO:

0x00,

Oxf8,
0xe0,
0x80,

Oxfc,

set index [lsearch $list_of_ events $drop_test_var]
set color_val [lindex $list of colors $index]
puts "Color selected is $color val"
set coloer $color_val -
puts "Value of variable=$drop_test_var"”

# Test procedure creating a drop-down list

proc test_drop_list { wl )}

{

global drop_test_var
global list of_ events
global list_of_colors
global list_of descrip
set filename event_details.dat

set data ""
set list_of_events ""
set list of colors ""
set list_of descrip ""

if {([(file readable $filename]} {

set fileid {open $filename "r"]
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while {{eof S$fileid] != 1} (
gets $fileid data
set list_of_ events [linsert S$Slist_of_ events end $data]
gets $fileid data
set list_of colors [linsert S$Slist_of_ colors end $data]
gets $fileid data
set list_of descrip [linsert $list_of_descrip end $data]
}
close $fileid
}

#
# Determine initial value.
# Enclose in gquotes because it may
# have spaces in the value.
#
set initial _value [lindex $list of_events O]

# Create drop list.
set list [DropListCreate $wl "Select Event: ™ \
40 8 drop_test_var "$initial value"]

# Fill in drop list with events.
foreach event $list_of_events {
$list insert end Sevent
}
button $wl.ok -text "OK" -command test_value
pack S$wl.ok ~side left -expand 1

# Comment out next line to remove test code.

set newframe Sw.frameList
test_drop_list Snewframe

# Frame-2.
# The following commands create the frame buttons.
frame $w.buttons
pack $Sw.buttons -side bottom -fill x -pady 2m
button $w.buttons.query -text " Query " -command { query }
button $w.buttons.new_query -text "New Query”"\
-command { new_query S$w}
button $w.buttons.exit ~text " Exit " -command { query_close $w }
button $w.buttons.help -text " Help " -command { source
queryHelp.tcl}
pack $w.buttons.query $w.buttons.new_query $w.buttons.exit \
$w.buttons.help -side left -expand 1

#
# Procedure query proc, which queries the eclipse depending
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# on the event selected by the user. It requires information

# about the event name, value on the time scale {obtained through
# upvar).

#

proc query { } |{
upvar #0 point_Obj po
upvar #0 infinite Obj ie
upvar #0 finiter Obj fr
upvar #0 finitel Obj fl
upvar #0 finite Obj £

global color countFE

global list of events

global list _of colors

global drop_test_var

global tk_library

set numFE $countFE

puts "No. of Fixed objects are ScountFE"

# Delete knowledge_base (older version) and create again
# by joining integral.dat and point.dat

file delete knowledge_base
set commandl "cat integral.dat point.dat > knowledge_base"
eval exec Scommandl

#

# Get the index of the event from list of events and pick
# the corresponding color from list_of colors

#

set index ([lsearch $list_of_events $drop_test_var]
set color_val [lindex $list_of colors $index]
set color $color_val

puts "Color selected is $color_val"”

set color_val (string trimleft "Scolor_val" "#"]
set color_val c$color_val

#

# The following lines of code open a channel and the
# eclipse commands are executed from the tcl script
#

set pipe {open "|eclipse" w+]
fconfigure $pipe -buffering line
puts Spipe compile(inference_engine).
puts Spipe compile{knowledge base}.

flush $pipe
if {(array exists pol} {
foreach index [array names po]
set val $po($index)
if {Sval == -1} ({
continue
} else {
set val {expr int($val)*100]

168



APPENDIX B. SOURCE CODE

set command "pt(S$val,Scolor_val,l}."
puts S$pipe Scommand

}

}

if {[array exists ie}} {
foreach index [array names ie] {

set val $ie($Sindex)

if {Sval == -1} {
continue

} else {

set val [expr int(Sval)*100]

}

set command "int (0,1200,$color_wval, 1200} ."
puts $pipe $command
}

if {([array exists fr]} ({
foreach index (array names fr] {

set val S$fr{$Sindex)

if {$val == -1} {
continue

} else {

set val [expr int(Sval)*100]

set command "int (0, $val,S$color_val,S$val)."
puts $pipe Scommand
}

if ([array exists fl]l} {
foreach index [array names f1l] {

set val S$fl(Sindex)

if {$val == -1} {
continue

} else {

set val [(expr int(Sval) *100]

}

set diff [expr 1200 - Sval]

set command "int ($val, 1200, Scolor_val,S$diff)."
puts S$pipe Scommand

}

if ({array exists £f]} {

for

set

set

{set indexl 0} {Sindexl<=$numFE} {incr indexl} {

set vall $£(Sindexl,1)

vall [expr int(Svall)*100]

set val2 $f(Sindexl, 2)

val2 (expr int(S$val2)*100]

set diff [expr Sval2-S$vall}

if ($vall !'= -1} {

set command "int ($vall,$val2, $color val,$diff).”
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puts Spipe $command
}

}

puts $pipe "halt.”

#

# The output of the execution is written to the file
# outfile.dat

#

set fileid [open outfile.dat "w+"]

fileevent $pipe readable (list Reader Spipe]
while {[eof S$pipe] != 1} {

gets $pipe response

puts Sresponse

puts $fileid Sresponse

}
close $fileid

# The following lines of code close a channel once
# it becomes readable

proc Reader { pipe } {
if [eof Spipe] {
catch {close $Spipe}
return
}
gets $pipe response
puts Sresponse
1

#

# The following lines of code read the data which is

# written onto the file outfile.dat and show a Message/
# dialog box giving the results.

proc showResult { d } {
if { [regexp {~(yes\.|bye)S$} Sdl} {
return 1
} elseif { [regexp {~\[eclipse.*$} $dl} {
return 1
} elseif { [regexp "~\[ \t]*s$" s$d]} {
return 1
} else {
return 0
}
}

if {[file readable outfile.dat]} {
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set counter 1
set flag 1
set fileid [open outfile.dat "r"]
#
#Are we at the end of the file?
#
while {[gets $fileid data] >=0 } {
incr counter
if (Scounter >= 19} {
set val [showResult $data]
if { Sval == 0} {

set flag 0
}
} else |
continue
}
}
close $fileid
}
#
# show Message/Dialog box
#

if { Sflag == 1} {
set result [tk messageBox -parent .query_ruler \
~-title Result -type ok -icon info \
-message "Query results: True !" ]

} else |
set result [tk_messageBox -parent .query_ruler \
-title Result -type ok -icon info \
-message "Query results: No !" ]

}

# Procedure invoked when New Query button is pressed.
proc new_query { w } {
upvar #0 point_Obj po
upvar #0 infinite Obj ie
upvar #0 finitel Obj f1l
upvar #0 finiter Obj fr
upvar #0 finite Obj f

global count countIL countFL

global ccuntFR countfFE

set color #2230f0

$w.c delete boxl tab tabl tab2 tab3 tab4 active activel \
active?2 active3 actived4 box fendl fixed

# Unsetting the various arrays

if ([array exists pol} { unset po
if {{array exists ie]} { unset ie
if {[array exists fl}} { unset fl
if {[array exists fr]} { unset fr
if {[array exists f]} { unset f }

—— e oy
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# Reinitializing various variables used in arrays
set count -1

set countIL -1

set countFL -1

set countFR -1

set countFE -1

# Giving Visual cues to the user.
Sw.c delete well5
Sw.c addtag well5 withtag [($w.c create rect 11.5¢ 4.5c 12.5c 3.5c

-outline black -fill [lindex [$w.c config -bg] 4]]
Sw.c create bitmap 12.00c 4.00c -bitmap questhead \
-background gray -tags well5

update
focus Sw.frameList

}
#Procedure invoked when Exit button is pressed

proc query close { w } {
destroy $w
}

#Creating the Query Screen.

canvas $c¢ ~width 17c -height 7c¢
pack $w.c -side top -fill x

# Create a font to show the text in the query window.

font create txtft2 -family Courier -size 12 -slant italic \
-weight bold
set newf txtft2

$Info about the box

set demo_boxInfo(a) O
set demo_boxInfo(motionProc) MoveNull
if ([winfo depth $c] > 1} {
set demo_boxInfo(boxStyle} "-fill {} -outline \
black -width 1"
set demo_boxInfo(active) "-£fill red \
-outline black -width 1"
} else {
set demo_boxInfo(boxStyle) "-f£fill {} -outline \
black -width 1"
set demo_boxInfo(active) "-fill black \
-outline black -width 1"

}

set demo_rulerInfo(grid) .25c

set demo_rulerInfo({left) [winfo fpixels Sc 1lc]
set demo_rulerInfo(right) ([winfo fpixels $Sc 13c]
set demo_rulerInfo(top) ([winfo fpixels $c 1lc]
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set demo_rulerInfo(bottom) [winfo fpixels $c 1.75c]
set demo_rulerInfo(size) [winfo fpixels $c .4c]
set demo_rulerInfo(normalStyle) "-£fill $color"
if {(winfo depth Sc] > 1} {
set demo_rulerInfo(activeStyle) "-fill red -stipple (}"
set demo_rulerInfo(deleteStyle) [list -fill red \
-stipple @[file join $tk_library demos images gray25.bmp}]
} else {
set demo rulerinfo(activeStyle} "-fill black -stipple {}"
set demo_rulerInfo(deleteStyle) ([list -fill black \
-stipple @(file join $tk_library demos images gray25.bmp]]
}

$c create line lc 0.5¢c 1lc 1lc 13c lc 13¢c 0.5¢c -width 2
$c create text .5c .75c -text "AM" -font Snewf -anchor s -fill maroon
for (set i 0} {$1i < 12} {incr i} |
set x [expr $i+l]
if {$i==0} {
Sc create line ${x}c lc ${x}c 0.6c -width 1
$c create line $x.25c lc $x.25c 0.8c -width 1
$c create line $x.5c lc $x.5c 0.7c -width 1
$c create line $x.75c lc $x.75c 0.8c -width 1
$c create text S$x.15c .75¢c -text "12" -font Snewf \
—-anchor s -fill maroon
} else {
$c create line S{x}c lc ${x}lc 0.6c -width 1
$c create line $x.25c lc $x.25c 0.8c -width 1
Sc create line $x.5c lc $x.5c 0.7¢c -width 1
$Sc create line $x.75c¢ lc $x.75¢c 0.8c -width 1
$c create text S$x.15c .75c -text $i -font Snewf \
-anchor s -fill maroon
}
}
# prints the last 12 on the scale
set x [expr $x+1]
$c create text $x.l7c .75c -text S$i -font Snewf -anchor s -fill maroon
$c create text [expr $x+llc .75¢c -text "PM" -font Snewf \
-anchor s -£fill maroon

# Tags below are for the Point object

$c addtag well withtag [Sc create rect 1.5¢c 4.5¢ 2.5¢c 3.5c \
-outline black -fill [lindex [$c config -bg] 4]]

Sc addtag well withtag [rulerMkTab $c ([winfo pixels $c 2c] \
[winfo pixels Sc 4c]]

$c create text 2c 5.25c¢c -text "Point"™ -fill marocon -font Snewf

$c create text 2c 5.75c —-text "Event" -fill maroon -font Snewf

# Tags below are for the Infinite Line object

$c addtag welll withtag [$c create rect 3.5c 4.5¢ 4.5c 3.5¢c \
-outline black -£fill [lindex [$c config -bg] 4]]

$c addtag welll withtag [rulerMkTablL Sc [winfo pixels $c 3.5c] \
(winfo pixels S$c 4.15c]]

$c create text 4c 5.25c -text "Limitless™ -fill maroon -font Snewf

$c create text 4c 5.75c ~text "Event" -fill maroon -font Snewf
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# Tags below are for the Fixed End object

$c addtag well2 withtag ($c create rect 5.5¢ 4.5c 6.5¢c 3.5c \
-outline black -fill {[lindex [$Sc config -bg)] 4]]

$c addtag well2 withtag [rulerMkTabFE $c [winfo pixels $c 5.52c] \
[winfo pixels Sc 4.15c]]

$c create text 6¢ 5.25¢c -text "Fixed" -fill maroon -font $newf

$c create text 6c 5.75¢c -text "Event" -fill maroon -font Snewf

# Tags below are for the Fixed left object

$c addtag well3 withtag [$c create rect 7.5¢c 4.5¢c 8.5c 3.5c \
~outline black -fill {[lindex [$c config -bg] 4]]

$c addtag well3 withtag [rulerMkTabFL $c [winfo pixels Sc 7.52c] \
[winfo pixels S$c 4.15c]]

Sc create text 8c 5.25c¢c -text "Fixed" -fill maroon -font S$newf

$c create text 8c 5.75¢ -text "Left"™ ~fill maroon -font S$newf

# Tags below are for the Fixed right object

$c addtag welld4 withtag ($c create rect 9.5¢ 4.5c 10.5c 3.5c \
-outline black -fill [lindex [$c config -bg] 4]]

$c addtag well4 withtag [rulerMkTabFR $c [winfo pixels Sc 9.52c] \
[winfo pixels $c 4.15c]]

$c create text 10c 5.25c¢c -text "Fixed" ~fill maroon -font S$newf

$c create text 10c 5.75¢c -text "Right" -fill marocon -font Snewf

# Tags below are for the question mark

$c addtag well5 withtag ([Sc create rect 11.5c 4.5c 12.5¢c 3.5¢c \
-outline black -fill [lindex [$c config -bg] 4]]

Sc addtag well5 withtag [rulerMkTabQues $c [(winfo pixels Sc 11.52c] \
[winfo pixels $c 4.15c]]

$c create text 1l2c 5.25c¢c -text "What's" -fill maroon -font Snewf

$c create text 12c 5.75¢c -text "True" -fill maroon -font Snewf

#Bindings below are for the Infinite Line object

$c bind welll <1> "rulerNewTabIL $c %x %y"

$c bind tabl <1> "rulerSelectTabIL S$c %x %y"

$c bind welll <Bl-Motion> "rulerMoveTabIL $c %x %y"

$c bind welll <Any-ButtonRelease-1> "rulerReleaseTabIL Sc"

#Bindings below are for the circular object

$c bind well <1> "rulerNewTab Sc %x %y"

Sc bind tab <1> "rulerSelectTab $c %x %y"

$c bind well <Bl-Motion> "rulerMoveTab $c %x %y”"

$c bind well <Any-ButtonRelease—1> "rulerReleaseTab Sc"

#Bindings below are for the Fixed End object

$c bind well2 <1> "rulerNewTabFE S$c %x $y"

$c bind tab2 <1> "rulerSelectTabFE $c %x %y"

$c bind well2 <Bl-Motion> "rulerMoveTabFE $c %x $y"

$c bind well2 <Any-ButtonRelease-1> "rulerReleaseTabFE Sc"

#Bindings below are for the Fixed Left object
$c bind well3 <1> "rulerNewTabFL Sc %x %y"
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$c bind tab3 <1> "rulerSelectTabFL $c %x %y"
Sc bind well3 <Bl-Motion> "rulerMoveTabFL S$c %x %y”"
$c bind well3 <Any-ButtonRelease-1> "rulerReleaseTabFL S$c"

#Bindings below are for the Fixed Right object

$c bind well4 <1> “"rulerNewTabFR Sc %x %y"

$c bind tab4 <1> "rulerSelectTabFR $c %x %y"

Sc bind welld4 <Bl-Motion> "rulerMoveTabFR $c %x $y"

$c bind welld4 <Any-ButtonRelease-1> "rulerReleaseTabFR S$c"

#Bindings below are for the QuestionHead object
$c bind wellS5 <1> "rulerInfoAll S$c"

# Controis tne wciking of the What's true icon
proc rulerInfoAll {w} {

global drop_test _var
puts "$drop_test_var"
$w delete well5
$w addtag wellS withtag [Sw create rect 11.5¢c 4.5c 12.5c 3.5c \
-outline black -fill [lindex {$w config ~bg] 4]]
Sw create bitmap 12.00c 4.00c -bitmap questhead \
-background blue -tags well$5
}

}

font delete txtft2
source Bruler.tcl
#!/usr/local/bin/wish

# Procedure boxSetup help in manipulating the small box
# attached to the Fixed Event icon.

proc boxSetup c {
upvar #0 demo_rulerInfo v
upvar #0 demo_boxInfo w
upvar #0 finite_Obj f

global color countFE

set vl [winfo fpixels $c .25c]

set tags [Sc gettags current]

if { Stags !'= "" } {
set cur [lindex $tags {[lsearch -glob Stags box?]]

} else {
set cur ""

}

Sc delete active2 boxl tab2

eval "$c create line $v(x) Sv(y) [expr Sv(x)+3$vli+Sw(a)] S$v(y) \
-fill Scolor -width 8 -tags (tab2 fixed}"

$c addtag active2 withtag tab2
# Creating box for reshaping the item....
eval "Sc create rect [expr $v(x)+Sw(a)+Svli-6] [expr Sv(y)-6]1 \

[expr $v(x)+$Sw(a)+$vl] [expr Sv(y)] Sw(boxStyle) \
-tags {boxl box}"
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#

offset

#
#

}

if {Scur !'= ""} ({
eval Sc itemconfigure boxl Sw(active)
}
set unit 35.457
set temp [expr int((($v(x)/Sunit)-1)*100)]
set xvalue [expr Stemp/100.00]
set temp2 [expr int((((Sw(a)+Sv(x))/Sunit)-1)*100)]

Value of 0.25 is added to the length because the starting

of the length is like that and also to come to the right figure
it is important for us to add 0.25 to length.

set ends {expr $temp2/100.00 + 0.25]

set f(ScountFE,1l) S$xvalue
set f(ScountFE,2) Sends

upvar #0 demo_boxInfo w

#Bindings for the box.
boxSetup Sc

Sc
Sc
Sc
Sc
Sc
Sc
$c

bind
bind
bind
bind
bind
bind
bind

box <Enter> "$c itemconf current Sw(active)"
box <Leave> "S$c itemconf current S$w(boxStyle}™
box <Bl-Enter> ""

box <Bl-Leave> ""

boxl <1> (set demo_boxInfo(motionProc) boxMovel }
boxl <Bl-Motion> "boxMovel Sc %x %y"
boxl <Any-ButtonRelease-1> "boxSetup $c"

# procedure boxMovel helps in moving the box on the time scale.

proc boxMovel { c x y} {

}

upvar #0 demo_rulerInfo v
upvar #0 demo_boxInfo w
set tmp [expr ([$c canvasx $x S$v(grid)])]

if {$tmp <= Sv(x)} |

set tmp $v(x)

if {$tmp >= $v(right)} {

set tmp Sv{right)

set newA [expr (S$tmp-Sv(x))]
if (SnewA != Sw(a)} {

$c move boxl [expr ($SnewA-Sw(a))] O
set w(a) SnewA

#1!/usr/local/bin/wish

#Tk color dialog window.

#The script below creates a window for the user to
#pick a color for an event.

proc color_get { parent initialcolor } ¢
upvar #0 demo_rulerInfo v
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set filename event_details.dat

global list_of_ events
global list_of descrip
global list _of colors

set data ""
set list_of events ""
set list_of descrip "*"
set list of colors ""
if {{file readable $filename]} {
set fileid (open $filename "r")
while {{eof $fileid] != 1} ({
gets $fileid data
set list_of_events [linsert $list of events end $data]
gets $fileid data
set list_of_colors [linsert $list_of colors end $data]
gets Sfileid data
set list_of_descrip ([linsert $list_of descrip end
Sdata]
}
close $fileid
}

set color [tk_chooseColor \
-parent Sparent \
~initialcolor Sinitialcolor \
-title "Color" ]

set v(normalStyle) "~fill S$color"”
#

# To search if the color currently selected is already in
# the database

#
set ans [lsearch $list_of colors $color]
if { Sans !'= -1 } {

set result ([tk_messageBox -parent . \
-title Error -type ok -icon error \
-message \
"Color already exists! Pick another"}
} else {
return S$Scolor
}
}

set color [color_get . maroon]

puts "Color=<$color>"
#!/usr/local/bin/wish

# Use of the html_library for online help.

#
# For this example, you must have
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# html library.tcl in the current directory.
#

puts "Loading html library.tcl”

source html_library.tcl

#
# Control look of links.
# The default is raised bevel.
#
global HMevents
array set HMevents {

Enter {-underline 1}
Leave {-underline 0}
1 {-underline 0}

ButtonRelease-1 {-underline 0}

# Global variables
set help initialized O
global help_initialized

# Creates a help window and calls up HTML helpfile.
proc help { helpfile }
global help initialized
global html
set text [help create $helpfile]

# Load help file
set html [help load_html Shelpfile]

# Initialize HTML
if | $help_initialized = 0 } {

set help injtialized 1
HMinit_win Stext
HMset_state Stext -size 2
HMset_indent S$text 1.2

} else {
HMreset win $text

}

HMparse_html Shtml "HMrender S$text"

# Handle the copy action for a text widget.
proc edit_copy { textwidget } {

# Check if any text is selected in textwidget.
set owner [selection own]

if { $owner == Stextwidget } {
# Clear clipboard.
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clipboard clear

catch {
clipboard append [selection get]
}

# Creates help window, called by help.
proc help create { filename } {

set top .helpwindow
set frm Stop.frm

if { [winfo exists Stop ] } {
wm deiconify S$top
return S$frm. text

}

toplevel Stop
# Set up wm options for .help

# Menubar
frame $top.menubar -bd 1 -relief raised

menubutton $top.menubar.file -text "File" -—underline 0 \
-menu S$top.menubar.file.menu

menubutton $top.menubar.edit -text "Edit" ~-underline 0 \
-menu $top.menubar.edit.menu

menu Stop.menubar.file.menu

# Reset to original message.
Stop.menubar.file.menu add command -label "Original Topic" \
-command "help_disp file $frm.text $filename"”

Stop.menubar.file.menu add command -label "Close" \
-command "destroy Stop"

menu $top.menubar.edit.menu
Stop.menubar.edit.menu add command ~label "Copy" \
~command "edit copy S$Sfrm.text"”

pack Stop.menubar.file $top.menubar.edit -side left
pack Stop.menubar -side top -fill x

# Main help area.

frame $frm -bd O

text S$frm.text -width 60 -height 20 \
-yscrollcommand "$frm.v_scroll set" \
~xscrollcommand "$frm.h_scroll set"

scrollbar $frm.v_scroll \
-command "$frm.text yview"
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scrollbar $frm.h_scroll -orient horizontal \
-command "$frm.text xview"

pack $frm.v_scroll -side right -fill y
pack $frm.h_scroll -side bottom -fill x
pack $frm.text -expand 1 -fill both

pack $frm -side top -expand 1 -fill both

# Return name of text widget.
return $frm.text

# Private procedure to handle a link.
proc HMlink_callback (win href} {
global html

If this is not a file link,
or if it has file://, you may
need to parse out the type

of URL.

I = IR FE S

# Load up HTML file.
set html [help load_html S$href]

# Display in text widget.
help_disp_html Swin $html

# Private procedure to display HTML.
proc help disp_html {(win html} {

# Display in text widget.

HMreset _win $win
HMparse_html $html "HMrender $win"

# Private procedure to load HTML file and display.
proc help disp file {win filename} {

set html [help load_html $filename]

help disp_html $win $html

# Private procedure to load HTML file.
proc help_ load html { filename } {
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# Default data in case of errors.
set data "<title>Bad file Sfilename</title>
<hl>Error reading $filename</hl><p>"

catch |
set fileid [open $filename]

set data [read $fileid}

close S$fileid

return S$data

help mainhelp.htm

:- use_module(library(£fd)).

$35333%33%%%3Inference Engined 333345833313

%t Note: only works for info that is T/F

% user types in pt(t,f,x) to find out if f(t)=x, and
% int(a,b,f,x) to find out if the integral of f between a and b is x.

% solve directly

pt(T,F,X) :- point(T,F,X).
% F is true throughout some interval containing T.
pt(TIFI l) =

A #< T,

B #> T,

C #= B-A,

integral (A,B,F,C).

% solve directly
int (A,B,F,X) :- integral(A,B,F,X), !.

% F is true over a super-interval of (A,B)
int(A,B,F,C) :-

X $#<= A,

Y #>= B,

Z #= Y-X,

integqral (X,Y,F,2),

C #= B-A.

% Sub-divide the interval
int(A,B,F,C) :-

X #<= A,
Y #> A,
Y #< B,
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Z §= Y-XI
integral X,Y,F,2),
int (Y,B, F, Temp),

C =Y - A + Temp.

:— use_module(library(fd)).

tE3333339%3% Knowledge base 33333333383 3%%%%

% all interval based information is represented using the integral.
% integral(a,b, f,x) is true iff the inteqral of f from a to b is x.
% e.g.: integral(0,10,running,10} -- running is true throughout (0,10).
%¥information true at an isolated point is represented with point.

% point(t,f,x) 1is true iff £(t)=x.

% e.g.: point (20, running,l) -- runing is true at time 20

% 1 == true; 0 == false.

$¥3%3%% Example %3333%1%%

$ running is true over (0,10), false over (10,15), true over (15,20)
% and (20, 30)

integral (0, 10, running, 10} .

integral (10, 15, running, 0) .

integral (15,20, running, S).

integral (20, 30, running, 10) .

% ran for an hour between 30 and 40.
integral{30,40, running,1}.

integral (600,700, cb08a60,100).
integral (0, 1200, cb0c860,1200).

integral (0, 1000,cb030£6, 1000).

integral (900, 1200, c6cbebc, 300).

integral (600, 700, cb0742c¢,100).

integral (600, 700, cdB84c60,100).
integral (700,800, cdB84c60,100).

inteqgral (100, 1000, c546e60, 900).

$point based info
point (10, running, 0) .
point (15, running,1l).
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point (20, running, 1).
point (25, running, 1).

point (1000,cfc3060,1).

point (900,c5¢c7e60,1).
point (1000,c5c7e60,1).

point (1000,cb0742¢c,1).
point (1000,c2230£0,1).
point (700, cdB84c60,1) .
#!/usr/local/bin/wish

#

# This program creates a window to accept the new file
# name from the user which will be used as to save

# event details.

#

set nf .newf

toplevel $nf -class Dialog
wm title $nf "New File"
wm transient Snf

wm geometry $nf +300+300

set filename event_details.dat

proc proc_ok {main} {
global nfname
if {Snfname == ""} {
set pmess [tk_messageBox -parent $main\
-title {Error} -type ok -icon error\
-message\
"Missing file name."]
} else {
destroy Smain
}

#
#Create the heading
#

global nfriame

frame $nf.fr

label $nf.fr.filename -text "Enter new file name:"
entry $nf.fr.fileentry -width 25 -textvariable nfname

grid config $nf.fr.filename -column 0 -row 1 -sticky w
grid config $nf.fr.fileentry ~column 1 -row 1 -sticky snew

183



APPENDIX B. SOURCE CODE

pack $nf.fr

frame $nf.fril

button $nf.frl.b -text " OK " -command {proc_ok $nf}
button $nf.frl.bl -text "Cancel" -command {destroy S$nf}
pack $nf.frl.b $nf.frl.bl -side left -padx 2 -pady 2
pack $nf.frl

focus $nf.fr.fileentry

<html>

<head><TITLE>System Database</TITLE></head>
<BODY BGCOLOR=#FFFFFF TEXT=#000>

<center><hl>How to Use Temporal Expert System Shell<br>
<u>Finding the contents of the Database</u></hl>

<h3><i>

<DT><A HREF="overviewhelp.htm">Qverview of the System</A>
<DT><A HREF="enterhelp.htm">Entering the information</aA>
<DT><A HREF="queryhelp.htm">Querying the system</A>
<DT><A HREF="symbolhelp.htm">Symbols and Icons</A>
<DT><A HREF="mainhelp.htm">Return to Main Menu</A>

</h3></center>
<h2><u>Finding the contents of the Database</u></h2>

User can find the contents of the Database by clicking on the
View Database choice available under the "Options" menu.
<br><br>

It displays the "Event Name", "Associated Color" and the
"Event Description” in a tabular fashion.

<br><br>

It is a dialog window and clicking on the "OK" button closes
the window.

</body></html>

<html>
<head><TITLE>Entering Information</TITLE></head>
<BODY BGCOLOR=#FFFFFF TEXT=#000>

<center><hl>How to Use Temporal Expert System Shell<br>

<u>Entering the Information</u></hl>

<h3><i>

<DT><A HREF="overviewhelp.htm">0Overview of the System</A>

<DT><A HREF="queryhelp.htm">Querying the System</A>

<DT><A HREF="symbolhelp.htm">Symbols and Icons</A>

<DT><A HREF="databasehelp.htm">Finding the contents of
Database </A>

<DT><A HREF="mainhelp.htm">Return to Main Menu</A>

</h3></center>
<h2><u>Entering the Information</u></h2>

User can enter an event details through the window called Enter

Information. This window is invoked by clicking on the Enter
information option under the Edit menu.
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Every event has a name, description and a temporal component.<br>
For example:<br><br>

John had a meeting at 4 p.m.<br><br>
The event name for this event is "Meeting", the event description
is "John had a meeting at 4 p.m. The text entry box labeled
"Event Name” is used for entering the name of the event. The
"Event description” text box provides a location for adding
event details. The user can move from one data field to another
either by tabbing to, or by clicking in the desired field. The
system prompts the user with an error message, if any of the
boxes are left empty.<br><br>
The next step is to pick a color. The "Pick Color"” button in
the Enter Information window invokes the color window. The
user can select a color for an event by filling in the numerical
values for red, green and blue. It is also possible to select
a color by sliding the triangular tab on the color scale for
each color. The user confirms his/her selection by clicking on
the "OK" button.<br><br>
There are different categories of events that can be represented.
Depending upon the category of an event, the user chooses an icon
from one of the boxes labeled "Point Event", "Limitless Event"
etc. The user can modify or change the position of the icon/icons
on the time scale. <br><br>
In order to select an icon, the user points and clicks on the
desired icon and it can be dragged along with the mouse pointer
to any position on the time scale. The icon may be positioned at
any of the grid intervals. The user may modify the position of
the icon on the time scale by pointing and clicking on the icon
and dragging it along with the mouse pointer to a new position.
<br><br>
After entering the current event, the user clicks on the "Contiue"”
button to add another event. Finally, clicking on the "Done"
button closes the current window, saving the details to a file.
Cancel button aborts the current operation, clears the screen
and takes the control back to the "Event Name" text box.

</body></html>

<html>

<head><TITLE>Temporal Expert System Help</TITLE></head>
<BODY BGCOLOR=#FFFFFEF TEXT=#000>

<center>

<hl>How to Use Temporal Expert System Shell<br>

<u>Main Menu</u></hl>

<h3><i>

<DT><A HREF="overviewhelp.htm">Overview of the System</A>

<DT><A HREF="enterhelp.htm">Entering the Information</A>

<DT><A HREF="queryhelp.htm">Querying the System</A>

<DT><A HREF="symbolhelp.htm">Symbols and Icons</A>

<DT><A HREF="databasehelp.htm">Finding the contents of
Database </BA>

</i></h3><center>

</body></html>

<html>
<head><TITLE>System Qverview</TITLE></head>
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<BODY BGCOLOR=#FFFFFF TEXT=#000>

<center><hl>How to Use Temporal Expert System Shell<br>

<u>Overview of the System</u></hl>

<h3><i>

<DT><A HREF="enterhelp.htm">Entering the Information</A>

<DT><A HREF="queryhelp.htm”">Querying the System</A>

<DT><A HREF="symbolhelp.htm">Symbols and Icons</A>

<DT><A HREF="databasehelp.htm">Finding the contents of
Database </A>

<DT><A HREF="mainhelp.htm">Return to Main Menu</A>

</h3></center>
<h2><u>Overview of the System</u></h2>

The Temporal Expert System Shell has two windows for Entering

the information and querying the information.

Clicking on the Edit menu and then on Enter Information will
invoke the window for Entering Information.

Similarly, Clicking on the Edit menu and then on the Query
Information will invoke the window for Querying Information.
<br><br>

Every event is associated with a unique color and the colors
currently in use can be found by clicking on the Colors Used

under the Options menu.

We can find out a list of events and their associated description
by clicking on the View Database under the Options menu.<br>

A list of all the symbols used is available under the Show symbols
category of the Options menu.

<br><br>

All the windows used are self explanatory and and easy to use.

The help options under the Enter Information and Query Information
provide help for those screens.

<br><br>

</body></html>

<html>
<head><TITLE>Querying the System</TITLE></head>
<BODY BGCOLOR=#FFFFFF TEXT=#000>

<center><hl>How to Use Temporal Expert System Shell<br>

<u>Quering the System</u></hl>

<h3><i>

<DT><A HREF="overview.htm”">Overview of the System</A>

<DT><A HREF="enterhelp.htm">Entering the information</a>

<DT><A HREF="symbolhelp.htm">Symbols and Icons</A>

<DT><A HREF="databasehelp.htm">Finding the contents of
Database </A>

<DT><A HREF="mainhelp.htm">Return to Main Menu</A>

</h3></center>
<h2><u>Querying the System</u></h2>

User can query an event through the window called Query Information.

This window is invoked by clicking on the Query information option
under the Edit menu. <br>
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The user can perform the following queries:<br><br>

1. Is an event true at the given time ? <br>

2. What is true about an event ? <br>

<br>

The layout of the query window is similar to the enter information

window. Select Event is the label for the dropdown event list box

shown by a button with a downward arrow sign. The user can view list
fo the events by clicking on this button. An event is selected from

the list by pointing and clicking on it. The user confirms his/her

selection by clicking on the "OK" button.<br><br>

To query the system about an event, the user selects and positions
the appropriate icon on the time scale and clicks on the "Query"

button. The system displays the result of the query in a separate

dialog window.<br><br>

As the name suggests the “New Query"” button allows

the user to perform a new query by clearing the screen and returning

control to the "Select Event" dropdown list box. The "Exit" button

closes the current window and transfers control back to the main

application window.<br><br>

</body></html>

<html>
<head><TITLE>Symbols and Icons</TITLE></head>
<BODY BGCOLOR=#FFFFFF TEXT=#000>

<center><hl>How to Use Temporal Expert System Shell<br>

<u>Symbols and Icons</u></hl>

<h3><i>

<DT><A HREF="overviewhelp.htm">Overview of the System</A>

<DT><A HREF="enterhelp.htm">Entering the information</A>

<DT><A HREF="queryhelp.htm">Querying the system</A>

<DT><A HREF="databasehelp.htm”">Finding the contents of
Database </A>

<DT><A HREF="mainhelp.htm">Return to Main Menu</A>

</h3></center>
<h2><u>Symbols and Icons </u></h2>

There are various Symbols and Icons which are used in Entering and
Querying information. These Symbols are explained below:<br><br>
POINT EVENT: Used for events which occur at precise points

over the given time scale. E.g., Phone rang at 2:00 pm.

<br><br>

LIMITLESS EVENT: Event that occured at some unknown time in past
and continues in future.E.qg., It has been raining today.
<br><br>

FIXED EVENT: Event that occured between two points on the given
time scale. Activity has precise start and end points.

E.g., We had lunch between 2 & 3 pm.

<br><br>

FIXEDLEFT EVENT: Event that starts at a known fixed point and
continues in future. E.g., Basketball game started at 6 pm

and went on till late evening.

<br><br>

FIXEDRIGHT EVENT: Event which started at some unknown point in
past and has fixed end point. Complement of FixedLeft Event.
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E.g., After a long sleep, I woke up at 12:00 pm.
<br><br>

WHAT'S TRUE: This symbol is used for querying the system.
It tells, all what is true for a selected event.

</body></html>
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